
DENTRIX ENTERPRISE 11.0.48
LEARNER’S GUIDE

California Department of   
Corrections and Rehabilitation

www.DentrixEnterprise.com  |  800.459.8067



Dentrix Enterprise 11.0.48 Learner’s Guide

ii     Copyright

PUBLICATION DATE

May 28, 2024

COPYRIGHT

© 2024 Henry Schein One. All rights reserved. No part of this publication may be reproduced, 
transmitted, transcribed, stored in a retrieval system, or translated into any language in any form by any 
means without the prior written permission of Henry Schein One.

SOFTWARE LICENSE NOTICE

Your license agreement with Henry Schein One, which is included with the product, specifies the 
permitted and prohibited uses of the product. Any unauthorized duplication or use of Dentrix Enterprise 
in whole or in part, in print, or in any other storage and retrieval system is forbidden.

LICENSES AND TRADEMARKS

The Henry Schein One logo is a registered trademark of Henry Schein One. Dentrix Enterprise and the 
Dentrix Enterprise logo are registered trademarks of Henry Schein One. Microsoft Windows, Excel, 
and Word are trademarks of Microsoft Corporation. All ADA CDT codes are protected by U.S. and 
International copyright laws; all rights reserved by the American Dental Association.

DENTRIX ENTERPRISE AND MICROSOFT WORD

Dentrix Enterprise can share its database with Microsoft Word, a word processing product created by 
Microsoft Corporation. To use Dentrix Enterprise with Microsoft Word, you need to license and install 
Microsoft Word.



 Contents    iii

Dentrix Enterprise 11.0.48 Learner’s Guide

Contents
Chapter 1: Treatment Request Manager........................................................... 1

Filtering Treatment Request Manager...............................................................................2

Adding Treatment Requests...............................................................................................2

Editing Treatment Requests................................................................................................4

Deleting Treatment Requests.............................................................................................6

Reviewing Treatment Requests..........................................................................................6

Canceling or Completing Treatment Requests.................................................................7

Chapter 2: More Information.............................................................................. 9
Viewing Demographics.....................................................................................................10

Viewing a Summary...........................................................................................................10

Adding Patient Tags..........................................................................................................11

Viewing Inmate Information..............................................................................................12

Viewing DPCs.....................................................................................................................13

Updating DPCs..................................................................................................................14

Placing Movement Holds..................................................................................................16

Closing Movement Holds.................................................................................................17

Locating Appointments.....................................................................................................19

Viewing Procedures...........................................................................................................19

Reviewing PAM Data.........................................................................................................20

Viewing Treatment Plans...................................................................................................20

Reviewing Vitals.................................................................................................................21

Managing Treatment Requests........................................................................................21

Chapter 3: Scheduling Assistant...................................................................... 23
Filtering the Scheduling Assistant List.............................................................................24

Customizing the Scheduling Assistant Filters.................................................................26

Copying the List of Records to other Programs..............................................................29

Scheduling Appointments from Scheduling Assistant...................................................30

Chapter 4: Family File....................................................................................... 33
The Family File Toolbar.....................................................................................................34

Selecting a Patient.............................................................................................................35

Viewing Patient Demographics........................................................................................39

Entering Patient Notes......................................................................................................39

Viewing and Hiding Patient Notes...................................................................................40

Exporting C-CDA Files......................................................................................................41



iv     Contents

Dentrix Enterprise 11.0.48 Learner’s Guide

Chapter 5: Quick Letters................................................................................... 43

Chapter 6: Office Journal.................................................................................. 45
Viewing Office Journal Entries..........................................................................................46

Adding Office Journal Entries..........................................................................................49

Editing Office Journal Entries...........................................................................................50

Deleting Office Journal Entries........................................................................................51

Printing Office Journal Entries..........................................................................................51

Chapter 7: Document Center........................................................................... 53
Scanning Documents........................................................................................................54

Importing Documents.......................................................................................................54

Printing Documents...........................................................................................................55

Editing Document Information.........................................................................................55

Modifying Document Attachments..................................................................................57

Deleting Documents.........................................................................................................58

Signing Documents...........................................................................................................59

Chapter 8: Appointment Book......................................................................... 61
The Appointment Book Toolbar.......................................................................................62

Scheduling Appointments for Treatment Requests........................................................63

Linking Treatment Requests to Appointments................................................................68

Breaking Appointments....................................................................................................70

Moving Appointments......................................................................................................71

Changing the Status of an Appointment.........................................................................71

Working with ASAP Appointments..................................................................................72

Printing the Appointment Book View..............................................................................72

Completing Appointments...............................................................................................73

Editing Appointments.......................................................................................................75

Unlinking Treatment Requests..........................................................................................75

Deleting Appointments.....................................................................................................76

Scheduling Events.............................................................................................................77

Rescheduling Events Using the Pinboard........................................................................79

Editing Events....................................................................................................................79



 Contents    v

Dentrix Enterprise 11.0.48 Learner’s Guide

Chapter 9: Chart................................................................................................ 81
The Chart Toolbar..............................................................................................................82

Opening Chart...................................................................................................................83

Handling Global Alerts......................................................................................................85

Assigning Encounter Numbers.........................................................................................85

Changing the Provider for a Charting Session................................................................86

Posting a Code for No Screening....................................................................................87

Verifying and Editing PAM Data.......................................................................................88

Verifying Patient Health Assessments..............................................................................88

Entering Prescription Orders............................................................................................88

Viewing Lab Orders...........................................................................................................89

Accessing MiPACS Imaging Software..............................................................................89

Changing Dentition in Chart.............................................................................................89

Charting Conditions..........................................................................................................90

Charting Existing Treatment.............................................................................................92

Charting Treatment Needs...............................................................................................94

Linking Conditions and Treatment-planned Procedures................................................97

Invalidating Conditions.....................................................................................................99

Referring Treatment to Off-site Specialists....................................................................101

Referring Treatment to In-house Specialists..................................................................103

Changing Progress Note Views......................................................................................105

Posting Treatment to Supernumerary Teeth.................................................................107

Editing Procedures..........................................................................................................109

Deleting Procedures........................................................................................................110

Invalidating Procedures...................................................................................................111

Editing Conditions...........................................................................................................113

Printing a Patient’s Chart.................................................................................................114

Printing Progress Notes and the Patient Chart.............................................................115

Viewing Patient Education Topics..................................................................................116



vi     Contents

Dentrix Enterprise 11.0.48 Learner’s Guide

Chapter 10: Perio Chart.................................................................................. 119
The Perio Chart Window.................................................................................................120

Entering New Perio Examinations..................................................................................121

Charting Probing Depths Greater than 9 Millimeters...................................................122

Recording Gingival Inflammation...................................................................................123

Entering Diagnostics.......................................................................................................124

Comparing Perio Exams..................................................................................................125

Changing the Perio Exam View......................................................................................126

Chapter 11: Clinical Notes.............................................................................. 129
Viewing Clinical Notes.....................................................................................................129

Changing the Provider....................................................................................................130

Entering Clinical Notes Using Templates......................................................................131

Entering Clinical Notes Manually...................................................................................132

Editing Clinical Notes......................................................................................................134

Signing Clinical Notes.....................................................................................................134

Appending Clinical Notes...............................................................................................135

Using Signature Manager...............................................................................................136

Chapter 12: Treatment Planner...................................................................... 137
Viewing Treatment Plans.................................................................................................138

Prioritizing Treatment Plans............................................................................................138

Changing Treatment Plan Approval Statuses................................................................139

Rejecting Treatment Plans..............................................................................................141

Creating Treatment Plan Cases......................................................................................142

Deleting Treatment..........................................................................................................143

Moving Treatment Between Cases................................................................................144

Printing the Patient Treatment Case Report..................................................................145

Chapter 13: End of Day................................................................................... 147
Verifying Completed Appointments..............................................................................147

Generating a Day Sheet..................................................................................................147

Signing Clinical Notes.....................................................................................................151

Generating the Aging/Credit Balance Report..............................................................151

Chapter 14: Continuing Care.......................................................................... 155
Tracking Perio Maintenance...........................................................................................155

Tracking Plaque Index > 20.............................................................................................157

Tracking Lab Cases..........................................................................................................158



 Contents    vii

Dentrix Enterprise 11.0.48 Learner’s Guide

Chapter 15: Ledger......................................................................................... 163
Ledger Toolbar.................................................................................................................163

Viewing the Transaction Log...........................................................................................165

Editing Procedures..........................................................................................................166

Deleting Adjustments......................................................................................................167

Generating a Walkout Statement...................................................................................168

Generating the Patient Ledger Report..........................................................................168

Chapter 16: Reports........................................................................................ 169
Single-User Mode Message............................................................................................169

The Office Manager Toolbar...........................................................................................170

Daily Appointment List....................................................................................................171

Production Summary Report...........................................................................................172

Patient List........................................................................................................................173

UDS - Encounter and User Statistics Report..................................................................176

Unsigned Clinical Notes Report.....................................................................................177



viii     Contents

Dentrix Enterprise 11.0.48 Learner’s Guide



Chapter 1: Treatment Request Manager    1

Dentrix Enterprise 11.0.48 Learner’s Guide

Chapter 1: Treatment Request 
Manager
Treatment Request Manager allows you to store and manage requests for treatment, from patients or 
providers, that require appointments to be scheduled. Prior to scheduling any appointment, except for an 
initial appointment for prosthetics, you must enter a treatment request for the patient. (Refer to your CDCR 
workflows for any other exceptions based on locations.) A provider must review the treatment request unless 
the request’s assigned type is “RC Dental Screening.” Then, you can schedule the appointment with that 
treatment request attached. The treatment request remains attached the appointment until that appointment 
is set complete.

Note: You can also create treatment requests from a patient’s More Information window. For more 
information, see “Managing Treatment Requests” in Chapter 2: More Information Window.

To open Treatment Request Manager, in Office Manager, from the File menu, click Treatment Request 

Manager. Or, you can click the Treatment Request Manager button  on the toolbar.
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Filtering Treatment Request Manager
You can filter the list of treatment requests to suit your preferences.

Note: Any changes you make to the filter settings are saved for the next time you access Treatment Request 
Manager, even after closing Dentrix Enterprise. Also, the filter settings are user specific, so each user can have 
his or her own filter settings to suit their preferences.

To filter the list

1.	 In Treatment Request Manager, set up the following filters as needed:

•	 Clinics – To view treatment requests for all clinics, select the All check box. Or, click the search 
button  to select the clinics whose requests you want to view. By default, the treatment requests for 
the clinic you are currently logged in to are displayed.

•	 Rev Prov – To view treatment requests that were reviewed by any provider, select the All check box. 
Or, click the search button  to select the providers whose reviewed requests you want to view.

•	 Req Type – To view treatment requests of any type, select the All check box. Or, click the search 
button  to select the types of requests you want to view.

•	 Req Status – To view treatment requests with any status, select the All check box. Or, click the search 
button  to select the statuses of requests you want to view.

•	 Req Date – To view treatment requests that are dated within a specified range of dates, enter or select 
the From and/or To dates (you can have an open-ended range).

2.	 Click the Refresh/Apply filter settings button .

Adding Treatment Requests
You can add a treatment request as needed. After the dentist has reviewed the 7362 paper form, in Treatment 
Request Manager, the OT will add a corresponding treatment request using the information on the form, 
including the dentist’s notations.

To add a treatment request

1.	 In Treatment Request Manager, click the Add Treatment Request button .
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The Select Patient dialog box appears.

2.	 Select a patient.

The New - Treatment Request dialog box appears.

3.	 Set up the following options as needed:

•	 Request Date – Today’s date is selected by default as the date of the treatment request, but you can 
specify a different date if necessary. For a patient request, enter or select date that the dental clinic 
received the treatment request from the patient; for a provider request for treatment, the initial date 
of the request; or for a provider request for a consult, the date that the consult was created.

•	 Description – Enter a brief description, such as the reason, for the treatment request.



4    Chapter 1: Treatment Request Manager

Dentrix Enterprise 11.0.48 Learner’s Guide

•	 Request Type – Select a type, such as the source, to assign to the treatment request. Refer to the 
appropriate job aid for information about which request types should be used.

Note: System-only request types are not available for selection. A system-only type is one that has 
been set up to allow requests of that type to be added only through HL7 messages.

•	 Status – Select a status to track the treatment request by. Refer to the appropriate job aid for 
information about which statuses should be used.

•	 Severity – This option is not used.

•	 Scheduled by Date – Enter or select the date by which an appointment for this treatment request has 
been requested to be scheduled. For a provider-requested treatment request, this date is the TIC date.

•	 Notes – Enter any additional information regarding the treatment request (such as information 
entered by the patient on Form 7362).

•	 Reviewed – To mark the treatment request as having been reviewed, select the check box. However, 
this can be done at a later time. For more information about reviewing a request, see “Reviewing 
Treatment Requests” in this chapter.

Note: You can mark a treatment request as having been reviewed at the same time it is entered.

4.	 Do one of the following:

•	 To save the treatment request, click Add. Then, on the message that appears, click OK.

•	 To save the treatment request and schedule an appointment for it (with or without the request having 
been reviewed), click Create Appt. However, you can schedule the appointment at a later time. For 
information about scheduling a treatment request, see “Scheduling Appointments for Treatment 
Requests” in Chapter 8: Appointment Book.

Note: After entering a treatment request, be sure to scan any forms and documents (such as Form 7362) into 
the patient’s Document Center.

Editing Treatment Requests
You can edit a treatment request as needed unless it has a system-only request type. A system-only request type 
is one that has been set up to allow requests of that type to be updated only through HL7 messages.

To edit a treatment request

1.	 In Treatment Request Manager, select a treatment request.

Note: Some details of the selected request, such as the patient name, appointment details, and notes, 
appear on the right side of the window. These details appear only if one request is selected.
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2.	 Click the Edit Treatment Request button . This button is available only if one treatment request is 
selected.

The Edit - Treatment Request dialog box appears.

3.	 Set up or modify any of the following options as needed:

•	 Request Date – Enter or select the date that the treatment request was submitted.

•	 Description – Enter a brief description, such as the reason, for the treatment request.

•	 Request Type – Select a type, such as the source, to assign to the treatment request.

Note: System-only request types are not available for selection. A system-only type is one that has 
been set up to allow requests of that type to be added only through HL7 messages.

•	 Status – Select a status to track the treatment request by.

•	 Scheduled by Date – Enter or select the date by which an appointment for this treatment request 
must be scheduled.

•	 Notes – Enter any additional information regarding the treatment request.

•	 Reviewed – To mark the treatment request as having been reviewed, select the check box. For more 
information about reviewing a request, see “Reviewing Treatment Requests” in this chapter.

Note: If the treatment request has already been marked as having been reviewed, and you clear the 
Reviewed check box, the Status reverts to Received automatically unless the Status is Scheduled, in 
which case, the Status does not change.

4.	 Do one of the following:

•	 To save the changes, click Update. Then, on the message that appears, click OK.

•	 To save the changes and schedule an appointment for the treatment request (with or without the 
request having been reviewed), click Create Appt. However, you can schedule the appointment at a 
later time. For information about scheduling a treatment request, see “Scheduling Appointments for 
Treatment Requests” in Chapter 8: Appointment Book.

Note: If a treatment request with a Scheduled status is updated through an HL7 message, the status of the 
treatment request changes to Received automatically.
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Deleting Treatment Requests
If the security rights assigned to your user account allow it, you can delete treatment requests as needed. If you 
delete a request that is linked to an appointment, that request will be unlinked from that appointment.

To delete a treatment request

1.	 In Treatment Request Manager, select one or more treatment requests.

2.	 Click the Delete Treatment Request button . This button is available only if at least one treatment 
request is selected.

3.	 On the confirmation message, click Yes.

4.	 On the message that appears, click OK.

Reviewing Treatment Requests
Typically, a provider must review a treatment request before an appointment for that request is scheduled. 
Exceptions to the rule for reviewing a request before scheduling it may include exam requests and Reception 
Center dental screening requests.

To review a treatment request

1.	 In the Edit - Treatment Request (or New - Treatment Request) dialog box, select the Reviewed check 
box.

The review options become available.
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2.	 Today’s date is selected by default as the Date of the review, but you can specify a different date if 
necessary. Enter or select the date that the treatment request was reviewed.

3.	 Click the Provider search button  to select the provider who reviewed the treatment request.

The Status changes to Reviewed automatically.

Note: If you clear the Reviewed check box, the Status reverts to Received automatically.

4.	 Enter additional Notes as needed.

5.	 Do one of the following:

•	 To save the changes, click Update. Then, on the message that appears, click OK.

•	 To save the changes and schedule an appointment for the treatment request, click Create Appt. 
However, you can schedule the appointment at a later time. For information about scheduling 
a treatment request, see “Scheduling Appointments for Treatment Requests” in Chapter 8: 
Appointment Book.

Canceling or Completing Treatment 
Requests
If the security rights assigned to your user account allow it, you can cancel or complete a treatment request as 
needed.

Notes:

•	 You cannot edit a treatment request once it has been canceled or completed.

•	 You cannot create an appointment for a treatment request that has been canceled or completed.

To cancel or complete a treatment request

1.	 In Treatment Request Manager, select a treatment request.

2.	 Click the Edit Treatment Request button .

The Edit - Treatment Request dialog box appears.
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3.	 From the Status list, select Canceled or Completed.

4.	 Click Update.

If your user account does not have the security right to cancel or complete treatment requests, a message 
appears and asks if another user can override the block this one time; otherwise, skip to step 7.

5.	 Click Yes.

A password dialog box appears.

6.	 The overriding user enters his or her credentials, and then clicks OK.

A confirmation message appears, stating that this treatment request will no longer be editable.

7.	 Click Yes.
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Chapter 2: More Information
More Information provides you with access to an entire overview of patient information, such as basic 
demographics, future appointments, treatment plans, medical information, aged balances, Dental Priority 
Classification, dental holds, patient movement, and effective communication requirements. You can also 
access other Dentrix Enterprise modules from More Information.

Since More Information serves as a dashboard, if the security rights assigned to your user account allow it, you 
will access More Information prior to working with a patient’s record.

To open More Information, with a patient selected in a patient-specific module, such as Chart, with a patient’s 
appointment selected in Appointment Book, or from Office Manager, click the More Information button 

 on the toolbar.
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Viewing Demographics
The following information from the patient’s Family File appears for your reference: age, birth date, gender, 
marital status, address, chart number, clinic, primary provider, patient status, billing type, home phone 
number, mobile phone number, work phone number, email address, and language preference.

Viewing a Summary
The Summary tab displays the following: the names of the dental insurance plans that are attached to the 
patient (if there are multiple, click a circled number icon to view the name of the corresponding plan), the 
names of the medical insurance plans that are attached to the patient (if there are multiple, click a circled 
number icon to view the name of the corresponding plan), the patient tags that are attached to the patient, 
the patient’s future appointments, continuing care attached to the patient, and the aged balances on the 
patient’s account.

To view a patient’s insurance information, click one of the circled numbers next to Dental Ins or Medical 
Ins, and then click the plan name.
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Adding Patient Tags
While Dentrix Enterprise does provide many options for generating reports so that they include patients that 
meet specific criteria, sometimes (especially for certain financial reports where filtering by account billing type 
isn’t quite what you want) you want to filter a report further to include patients that meet custom, patient-
specific criteria. For this, Dentrix Enterprise provides patient tags, which can be assigned to and removed from 
patients individually as needed. You can also assign patient tags to patients to quickly identify or categorize 
them internally instead of having to type the same thing over and over in a patient note for every applicable 
patient.

Important: You will assign a patient tag to a patient’s record if the patient requires pre-medication before 
dental treatment.

To assign a patient tag to a patient

1.	 On the Summary tab of a patient’s More Information, click the Tags link.

Note:
•	 If the patient does not have any tags, the tag icon on the button is white .

•	 If the patient has tags, the tag icon on the button is yellow .

The Select Tags dialog box appears.

2.	 Select a tag in the Available Tags list, and then click the Add button .

3.	 Click OK.
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Viewing Inmate Information
The Inmate tab displays the following information about the inmate as stored in the Strategic Offender 
Management System (SOMS) database: requirements for effective communication (EC) or the Americans 
with Disabilities Act (ADA), custody level, current status, work assignment, earliest possible release date, 
external patient ID, adaptive support needs, TABE score and date, SLI, LEP, primary and secondary 
communication methods, dental chronic care, mental health level of care (MH LOC), clinical risk, housing 
program and type, reception center (RC) admit date, RC length of stay, RC eligibility, bed details, and 
movement history. You cannot change any of this information.

Notes:

•	 To view the bed details (block, cell, bed, and yard), expand Bed Details.

•	 To view the inmate’s requirements for EC or ADA, click the link under Effective Communication/ADA. 
If the link text is “None,” the inmate does not have any requirements. If the link text is “Yes,” the inmate 
has requirements.

•	 To view the inmate’s adaptive support needs, click the link under Adaptive Support Needs. If the link 
text is “None,” the inmate does not have any adaptive support needs. If the link text is “Yes,” the inmate 
has adaptive support needs. An adaptive support need appears as a category name (such as Behavior or 
Social Interactions) and a description or instructions.
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Viewing DPCs
You can view an inmate’s Dental Priority Classification (DPC) on the Inmate tab. If “None” appears, or  if 
the classification is not correct, the dentist will update the DPC from the Clinical Notes module.

To view the DPC history

Click the link under Dental Priority Classification.

The Dental Priority Classification dialog box appears.

Notes:

•	 If a DPC update is required with every clinical note, to update a patient’s DPC, you must do so by 
signing a clinical note and then selecting a DPC code when prompted. For information about signing 
clinical notes, see “Signing Clinical Notes” in Chapter 11: “Clinical Notes.” However, if a DPC update is 
allowed without a clinical note, you can update a patient’s DPC from the More Information window (see 
“Updating DPCs” in this chapter).

•	 In the Dental Priority Classification dialog box, you can also delete an entry from the History list by 
selecting that entry and then clicking Delete.
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Updating DPCs
An inmate’s Dental Priority Classification (DPC) appears on the Inmate tab. If a DPC update is required 
with every clinical note, to update a patient’s DPC, you must do so by signing a clinical note and then 
selecting a DPC code when prompted. For information about signing clinical notes, see “Signing Clinical 
Notes” in Chapter 11: “Clinical Notes.” However, if a DPC update is allowed without a clinical note, you can 
update a patient’s DPC from the More Information window.

To update a DPC

1.	 Click the link under Dental Priority Classification.

The Dental Priority Classification dialog box appears.

2.	 Click Update Status.
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The Update DPC Status dialog box appears.

3.	 Click the Provider search button  to select the correct provider. 

4.	 Click the Encounter # search button  to select the correct encounter number.

5.	 Select the correct status based on the patient’s treatment plans.

6.	 Click Select.
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Placing Movement Holds
If the security rights assigned to your user account allow it, you can place a movement hold on a patient.

Note: A patient can have only one active movement hold at a time.

To place a movement hold

1.	 On the Inmate tab, click the link under Movement Hold. If the link text is “None,” the inmate does not 
have an active movement hold.

The Movement Holds dialog box appears.

Note: In this dialog box, you can also delete a hold by selecting it and then clicking Delete. However, you 
cannot delete a hold that was received through an HL7 message.

2.	 Click Add.

The Add Movement Hold dialog box appears.

3.	 Set up the following options:

•	 Hold Date – The date that the hold went or will go into effect.

•	 Hold Provider – The provider placing the hold.

•	 Hold Type – “Dental” appears for your reference.
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•	 Hold Reason – The reason for the hold.

•	 Approved Date – The date that the hold was approved. This may be entered later if needed by editing 
the hold.

•	 Notes – Additional details regarding the hold.

•	 Encounter # – The applicable encounter number.

4.	 Click Save.

Closing Movement Holds
Once a movement hold is no longer necessary, you can close it if the security rights assigned to your user 
account allow it.

To close a movement hold (today only)

1.	 On the Inmate tab, click the link under Movement Hold. If the link text is “Yes,” the inmate has an 
active movement hold.

The Movement Holds dialog box appears.

2.	 Select a movement hold, and then click Close Selected Hold.

The Provider Selection dialog box appears.

3.	 Enter your search criteria, and then click Show Results.
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The matching providers appear.

4.	 Select the provider releasing the hold, and then click OK.

A message appears and states that the date of the release will be today.

5.	 Click OK.

To close a movement hold (today or prior)

1.	 On the Inmate tab, click the link under Movement Hold. If the link text is “Yes,” the inmate has an 
active movement hold.

The Movement Holds dialog box appears.

2.	 Select a movement hold, and then click Edit.

The Edit Movement Hold dialog box appears.
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3.	 Set up the following options:

•	 Closed Date – The date that the hold is being released.

•	 Provider Closed – The provider releasing the hold.

4.	 Click Save.

Locating Appointments
The Appointments tab displays the patient’s past appointments (unless the Hide Past Appointments 
check box is selected), future appointments, and appointments on the Unscheduled List (unless the Hide 
Unscheduled Appointments check box is selected).

To view an existing appointment, select it, and then click the Locate Appointment button .

Viewing Procedures
The Procedures tab displays the completed, treatment-planned, and/or existing procedures for the patient, 
according to which check boxes are selected.

Tip: To view only completed procedures, make sure that the Completed check box is selected and that the 
other check boxes are clear.



20    Chapter 2: More Information

Dentrix Enterprise 11.0.48 Learner’s Guide

Reviewing PAM Data
The Medical Alerts tab displays the patient’s problems, allergies, and medications (PAM) and smoking status.

Important: Since all PAM data will be entered in PowerChart, you cannot enter or edit PAM data in Dentrix 
Enterprise. For information about opening PowerChart, see “Verifying and Editing PAM Data” in Chapter 9: 
“Patient Chart.”

Viewing Treatment Plans
The Treatment Plans tab displays all the patient’s treatment-planned procedures. You can click the name of a 
treatment plan to view only the treatment-planned procedures that are part of that case.

Important: Treatment that a patient has refused is placed in a rejected case in Treatment Planner. To include 
rejected cases in the list, make sure that the Rejected check box is selected.
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Reviewing Vitals
The Health Assessments tab displays the health assessments that were entered for the patient.

Important: Since vitals entered from Dentrix Enterprise would appear only in Dentrix Enterprise and not 
in PowerChart, you cannot enter or edit patient health assessments in Dentrix Enterprise. All vitals will be 
entered in PowerChart. For information about opening PowerChart, see “Verifying and Editing PAM Data” 
in Chapter 9: “Patient Chart.”

To view a patient’s vitals in a graph format, select a patient health assessment, and then click the Patient 

Health Assessment button .

Managing Treatment Requests
The Treatment Requests tab displays the treatment requests that were entered for the patient.

Do any of the following:

•	 To view a treatment request’s notes and linked appointment’s details, select the request. The details appear 
only if one request is selected.

•	 To create a new treatment request, click the Add Request button . For information about adding a 
treatment request, see “Adding Treatment Requests” in Chapter 1: Treatment Request Manager.
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•	 To delete one or more treatment requests, select the requests, and then click the Delete Request(s) button 
. On the confirmation message that appears, click OK.

•	 To schedule an appointment for one or more treatment requests, select the requests, and then click the 
Create new appointment with selected request(s) button . If a selected request is already linked to an 
appointment, you will be asked if you want to unlink the request from its current appointment and link 
that request to the new appointment that will be created. For information about scheduling a treatment 
request, see “Scheduling Appointments for Treatment Requests” in Chapter 8: Appointment Book.

Note: You cannot create an appointment for a treatment request with a Canceled or Completed status.

•	 To unlink a treatment request from an appointment, select the request, and then click the Unlink button 
. This button is available only if one request is selected. On the confirmation message that appears, 

click Yes.

Note: The status of a treatment request changes automatically according to the following criteria:

•	 With a reviewing provider selected, the status changes to Reviewed.

•	 Without a reviewing provider selected, the status changes to Received.
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Chapter 3: Scheduling 
Assistant
Scheduling Assistant enhances the scheduling workflow by combining the Continuing Care, Unscheduled 
Appointments, ASAP, Unscheduled Treatment Plans, and Treatment Request Manager lists into one window. 
Also, Scheduling Assistant includes quick access to a patient’s details and Office Journal entries.

To open Scheduling Assistant, in Family File, Ledger, Chart, Appointment Book, or Office Manager, from 
the File menu, click Scheduling Assistant. Or, you can click the Scheduling Assistant button  on the 
toolbar.

Tip: You can click the name in the Patient Name column of any record in Scheduling Assistant to open that 
patient’s More Information.
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Filtering the Scheduling Assistant List
You can filter the list of patients in Scheduling Assistant to suit your preferences.

Notes:

•	 Any changes you make to the filter settings are saved for the next time you access Scheduling Assistant, 
even after closing Dentrix Enterprise. Also, the filter settings are user specific, so each user can have his or 
her own filter settings to suit their preferences.

•	 A patient may appear more than once in the list if he or she has multiple items (continuing care types, 
broken appointments, ASAP appointments, treatment plans, or treatment requests) that meet the criteria 
of the filter settings for the selected list type.

To filter the list

1.	 In Scheduling Assistant, set up the following filters as needed:

•	 List – Select the type of list that you want to view:

•	 Continuing Care – The list displays patients with continuing care attached to their records and/
or who need continuing care appointments scheduled. The number in square brackets is a count 
of patients that meet the Continuing Care filter settings.

If none of the check boxes under Continuing Care are selected, the list displays patients with 
continuing care attached to their records, whether or not appointments have been scheduled for 
those continuing care types. To view patients with unscheduled continuing care types that will 
be due starting at a certain time and/or that have been overdue for a certain length of time, select 
any of the following check boxes:

•	 Due w/out Appointments – Any continuing care types that will be due.

•	 Overdue 1-30 Days – Any continuing care types that have been overdue for one to 30 days.

•	 Overdue 31-60 Days – Any continuing care types that have been overdue for 31 to 60 days.

•	 Overdue 61-90 Days – Any continuing care types that have been overdue for 61 to 90 days.

•	 Overdue >90 Days – Any continuing care types that have been overdue for more than 90 
days.

Notes:

•	 When selecting and clearing check boxes, the list of results will not be updated until you 
click the Refresh/Apply filter settings button .

•	 A continuing care type is considered due or overdue according to the specified Due w/
out Appointments Date Range of the Continuing Care filter. For information about 
customizing the Continuing Care filter, see “Customizing the Continuing Care Filter 
Settings” in this chapter.

•	 The only continuing care types that will be used are those for tracking outstanding lab 
cases, tracking patients with plaque indexes over 20, biopsies, and periodontal maintenance. 
However, the plaque index and perio maintenance types will be for informational purposes 
only. Prophy and perio maintenance will be tracked through treatment plans. Exams will be 
tracked with an external report.
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•	 Unscheduled Appointments – The list displays patients who have broken appointments that 
need to be rescheduled. The number in square brackets is a count of patients that meet the 
Unscheduled Appointments filter settings.

Notes:

•	 If a patient is transferred, Dentrix Enterprise will automatically cancel his or her existing 
appointment and place the patient onto the Unscheduled Appointments list at the new 
location. The broken appointment reason will be Patient Transfer.

•	 For information about customizing the Unscheduled Appointments filter, see “Customizing 
the Unscheduled Appointments Filter Settings” in this chapter.

•	 ASAP Appointments – This list is not used because appointments are not pre-booked. The 
patient count for this list should always be zero.

•	 Unscheduled Tx Plans – The list displays patients who have unscheduled treatment plans. The 
number in square brackets is a count of patients that meet the Unscheduled Tx Plans filter 
settings.

Note: For information about customizing the Unscheduled Tx Plans filter, see “Customizing the 
Unscheduled Tx Plans Filter Settings” in this chapter.

•	 Unscheduled Tx Requests – The list displays patients who have unscheduled treatment requests. 
The number in square brackets is a count of patients that meet the Unscheduled Tx Requests 
filter settings. This list is the same list that is shown in the Treatment Request Manager (see 
Chapter 1: Treatment Request Manager); however, it is provided in the Scheduling Assistant, so 
staff can work in a centralized area to schedule appointments.

Note: For information about customizing the Unscheduled Tx Requests filter, see “Customizing 
the Unscheduled Tx Requests Filter Settings” in this chapter.

•	 Clinics – To view patients in all clinics, select the All check box. Or, click the search button  to 
select the clinics whose patients you want to view. By default, the patients for the clinic that you are 
currently logged in to are displayed.

•	 Prov – To view patients for any provider, select the All check box. Or, click the search button  to 
select the providers whose patients you want to view.

2.	 Click the Refresh/Apply filter settings button .
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Customizing the Scheduling Assistant 
Filters
In Scheduling Assistant, you can customize the filter settings for the Continuing Care, Unscheduled 
Appointments, Unscheduled Tx Plans, and Unscheduled Tx Requests lists.

Note: Any changes you make to the filter settings are saved for the next time you access Scheduling Assistant, 
even after closing Dentrix Enterprise. Also, the filter settings are user specific, so each user can have his or her 
own filter settings to suit their preferences.

Tip: You can reset all filter settings for Scheduling Assistant to the system defaults by clicking the Reset 
Filters button .

Customizing the Continuing Care Filter Settings
1.	 Click Continuing Care (it becomes a hyperlink when you position your pointer over it).

The Continuing Care Filter dialog box appears.

2.	 Set up the following options:

•	 Due w/out Appointments Date Range – To include patients with unscheduled continuing care 
types that have due dates within a specified range of dates, enter or select the From and/or To dates 
(you can have an open-ended range). One month prior to today is selected as the From date by 
default.

•	 Care Types – To include patients with unscheduled continuing care of any type, select the All check 
box. Or, click the search button  to select the desired continuing care types. The All check box is 
selected by default.

3.	 Click Apply.
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Customizing the Unscheduled Appointments Filter Settings
1.	 Click Unscheduled Appointments (it becomes a hyperlink when you position your pointer over it).

The Unscheduled Appointments Filter dialog box appears.

2.	 Set up the following options:

•	 Broken Date Range – To include patients with appointments that were broken within a specified 
range of dates, enter or select the From and/or To dates (you can have an open-ended range). One 
month prior to today is selected as the From date by default.

•	 Broken Reason – To include patients with broken appointments that were broken for any reason, 
select the All check box. Or, click the search button  to select the desired reasons. The All check 
box is selected by default.

•	 Appt. Reason – To include patients with broken appointments that have any appointment reason 
attached, select the All check box. Or, click the search button  to select the desired appointment 
reasons. The All check box is selected by default.

3.	 Click Apply.

Customizing the Unscheduled Tx Plans Filter Settings
1.	 Click Unscheduled Tx Plans (it becomes a hyperlink when you position your pointer over it).

The Unscheduled Treatment Plans Filter dialog box appears.
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2.	 Set up the following options:

•	 Proc Date Range – To include patients with unscheduled treatment-planned procedures within 
a specified range of dates, enter or select the From and/or To dates (you can have an open-ended 
range). One month prior to today is selected as the From date by default.

•	 Procedure Range – To include patients with unscheduled treatment-planned procedures for any 
procedure code, select the All check box. Or, click the search button  to select the desired 
procedure codes. The All check box is selected by default.

•	 Proc Approval Status – To include patients with unscheduled treatment-planned procedures 
regardless of the approval status, select the All check box. Or, click the search button  to select the 
desired approval statuses. The All check box is selected by default.

3.	 Click Apply.

Customizing the Unscheduled Tx Requests Filter Settings
1.	 Click Unscheduled Tx Requests (it becomes a hyperlink when you position your pointer over it).

The Unscheduled Treatment Requests Filter dialog box appears.

2.	 Set up the following options:

•	 Date Range – Select whether to include patients with treatment requests by the request date or the 
schedule-by date

•	 From/To – To include patients with treatment requests that have either a request date or a schedule-
by date (according to the Date Range selection) within a specified range of dates, enter or select the 
From and/or To dates (you can have an open-ended range). One month prior to today is selected as 
the From date by default.

•	 Severity – This option is not used.

•	 Request Types – To include patients with treatment requests of any type, select the All check box. 
Or, click the search button  to select the desired types. The All check box is selected by default.

•	 Request Statuses – To include patients with treatment requests regardless of the status, select the All 
check box. Or, click the search button  to select the desired statuses. The All check box is selected 
by default.

•	 Include requests attached to unscheduled appt – Either select this check box to include patients 
with unscheduled and scheduled treatment requests, or clear this check box to include only patients 
with scheduled treatment requests.

3.	 Click Apply.
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Copying the List of Records to other 
Programs
You can copy selected records to the Windows Clipboard, so you can paste the content into another program, 
such as Microsoft Word or Excel. Only the details that you can see in the columns of the list are copied.

To copy the list

1.	 In Scheduling Assistant, select one or more records. To select multiple, non-adjacent records, while 
pressing Ctrl, click the desired records. Alternatively, to select a range of adjacent records, click the first 
record of the desired range, and then, while pressing Shift, click the last record of the desired range.

2.	 Click the Copy Selected to Clipboard button .

3.	 Use your third-party program’s paste functionality to paste the contents into that program.
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Scheduling Appointments from 
Scheduling Assistant
You can schedule an appointment from Scheduling Assistant.

Note: You cannot create an appointment for a treatment request with a Canceled or Completed status.

To schedule an appointment

1.	 In Scheduling Assistant, select a record.

2.	 Click the Create Appointment button . This button is available only if one record is selected.

The Select View dialog box appears. Also, Appointment Book opens in the background if it is not already 
open.
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3.	 Select an Appointment Book view.

4.	 Click either Select or OK.

The New Appointment Information dialog box appears.

Notes:

•	 If you are scheduling a continuing care appointment, the continuing care type and assigned provider 
are attached to the appointment automatically.

•	 If you are rescheduling a broken appointment, the original appointment details, such as the provider, 
reason, description, length, and amount, are entered automatically in the new appointment.

•	 If you are scheduling a treatment-planned procedure, it is linked to the appointment automatically 
along with the assigned provider and any corresponding continuing care.

•	 If you are scheduling a treatment request, it is linked to the appointment automatically along with 
the patient’s provider.

5.	 Set up the appointment details, such as the provider, encounter number, and reason.

6.	 Click Pin Board.

7.	 Navigate to the desired date for the appointment, and then drag the patient’s appointment from the 
Pinboard to the desired time slot in the correct operatory.

8.	 On the confirmation message, click Yes.
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Chapter 4: Family File
Family File stores and displays important patient information, such as a patient’s name, address, phone 
number, medical alerts, birth date, insurance coverage, employer, and referral information.

Note: Each patient will have a separate Family File record.

The Family File window contains several sections, called “blocks,” that display information. By double-
clicking any of these blocks, you can enter, edit, or delete corresponding patient information.

Patient Information 
Block

Medical Alerts Block Continuing 
Care Block

Insurance 
Information Block

Patient Notes 
Block

Employer Block

Referral Blocks
Billing and Payment 
Agreement Block

Notes:

•	 Patient information in Family File will be downloaded automatically from SOMS, but some information 
will need to be added manually.

•	 When a patient is paroled or discharged, Dentrix Enterprise will automatically change the patient’s 
assigned clinic to the clinic named Z_Paroled/DC and change the patient’s status to Archived. If the 
patient re-offends, his or her record will be reactivated automatically.
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The Family File Toolbar
The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

The function of each button on the toolbar is explained in the following table.

Button Name Description

 More Information Opens the selected patient’s More Information window.

 Patient Chart Opens the selected patient’s Patient Chart.

 Ledger Opens the selected patient’s Ledger.

 Appointment Book Opens the Appointment Book module.

 Office Manager Opens the Office Manager module.

 Quick Letters Opens the Quick Letters dialog box.

 Continuing Care Opens the selected patient’s Continuing Care list.

 Prescriptions Opens PowerChart.

 Office Journal Opens the selected patient’s Office Journal.

 Document Center Opens the selected patient’s Document Center.

 Message Center Opens the Cerner Message Center.

 Patient Education Opens the Patient Education dialog box.

 Select Patient Opens the Select Patient dialog box to select a patient.

 Referral Analysis Opens the selected patient’s Referral Analysis dialog box.

 Patient Notes Report Opens the Patient Notes Report dialog box to print notes.

 Medical Consultation Opens PowerChart.

 Clinical Notes Opens the selected patient’s Clinical Notes window.

 Patient Referrals Opens the selected patient’s Patient Referrals dialog box.

 Patient Health Exchange Opens the selected patient’s Patient Health Exchange dialog box.
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Button Name Description

DXOne Reports Click to open DXOne Reporting to generate and manage reports.

Signature Manager Click to open the Signature Manager dialog box to sign multiple 
clinical notes at one time.

Scheduling Assistant Click to open the Scheduling Assistant window, which can help 
enhance your scheduling workflow.

Selecting a Patient
If you want to view or edit a patient’s information in any patient-specific module (Family File, Ledger, Chart, 
Treatment Planner, Document Center, and Office Journal) or schedule an appointment for a patient (in 
Appointment Book), you must first select the patient.

To select a patient

1.	 In a patient-specific module, click the Select Patient button  on the toolbar.

The Select Patient dialog box appears.

Tip: For your convenience, the patients that were selected most recently appear under Previously 
Selected Patients. If the patient you are looking for appears in the list box, you can select that patient’s 
name without having to search for it first.
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2.	 Do one the following:

•	 On the Search By tab, select which type of patient information that you want to search by, select 
which clinics you want to search in, and then begin typing letters or numbers (depending on the type 
of information).

If you type at least three letters or numbers (or all digits of a birth date), any patients that match your 
search criteria appear automatically in the results list. Continue typing as needed to narrow the search 
results. If you have only one or two letters or numbers entered, click Search to view the patients that 
match your search criteria.

Tip: You can use the wildcard character (%) when performing searches.

Notes:

•	 The Chart # in Dentrix Enterprise corresponds to the CDCR #. For patients with multiple 
CDCR #s, Dentrix Enterprise uses only the controlling CDCR #, which should match 
PowerChart and SOMS. To view other CDCR #s, open PowerChart, and then review the 
Identifiers section within the Patient Information. Also, you can review patient identification 
numbers in SOMS.

•	 The Other ID in Dentrix Enterprise corresponds to the PID. Scroll to the right in either the 
results list or the Previously Selected Patients list to see the Other ID.
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•	 On the Appointments tab, select a date (the default date will be today’s date each time you open the 
Select Patient dialog box if the Always start with “Today” check box is selected), and select which 
clinics you want to search in. The patients who have an appointment on the selected day appear in 
the results list.
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•	 On the Advanced Search tab, type part or all of any of the types of patient information that you 
want to search by (you can search by multiple criteria), select any of the patient statuses, select which 
clinics you want to search in, and then click Search.

Note: You can search for a patient by last name, first name, chart number (CDCR number), or date 
of birth. If you cannot locate the patient in the dental database, create a ticket in Solution Center.

3.	 Double-click a patient name in the results list.
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Viewing Patient Demographics
The Patient Information block (the top section) displays a patient’s demographics. To view more details, 
double-click the Patient Information block.

Note: Certain pre-populated information from SOMS cannot be edited. This includes the patient’s name, 
date of birth, and other assigned IDs.

Entering Patient Notes
A patient note can include any information about a patient that you want to be viewed internally in your 
office and not be seen by the patient.

Note: Patient notes apply to an individual patient, and you can view them only from the patient’s 
appointment information in Appointment Book, from the patient’s Family File, or on the patient notes 
report.

Important: Anyone can edit and delete the text of a patient note. Use a clinical note to add any information 
that you want to remain permanently on a patient’s record.

To enter a patient note

1.	 With a patient selected in Family File, double-click the Patient Notes block.

The Patient Note dialog box appears.

2.	 To insert the current date where the text cursor is positioned in the field, click Insert Dateline.

3.	 Type the note. A patient note is limited to 4,000 characters.

Note: You `can click the Check Spelling button  to check the spelling of the note text (this button is 
available only if a certain preference setting has been enabled).

4.	 Click OK.
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Viewing and Hiding Patient Notes
Each time you log on to Dentrix Enterprise, patient notes are hidden for all patients by default. When you 
first open the Family File of a patient with a patient note, the patient note is hidden by default. Afterwards, 
for each patient that you select in the Family File, the notes are viewed or hidden depending on the state of 
the previously selected patient’s notes.

Notes:

•	 Patient notes apply to an individual patient, and you can view them only from the patient’s appointment 
information in Appointment Book, from the patient’s Family File, or on the patient notes report.

•	 If no notes have been entered for the patient, the block displays “No Note,” and the View/Hide option is 
not available.

To view patient notes

If the notes are being hidden, you can view the notes by clicking View. (When you click View, the button 
label changes to, “Hide.”)

To hide patient notes

If the notes contain confidential information, it is recommended that you hide the notes by clicking Hide 
after each time the notes are viewed. (When you click Hide, the button label changes to, “View.”)
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Exporting C-CDA Files
If the security rights assigned to your user account allow it, you can export a C-CDA (Consolidated-Clinical 
Document Architecture) file that can be shared with another healthcare professional. The C-CDA file contains 
a summary of a patient’s clinical information from the following: the most recent visit, laboratory test results, 
medical alerts/problems, and medications.

To export a patient’s health information

1.	 With a patient selected in Family File, click the Health Exchange button  on the toolbar.

The Patient Health Exchange dialog box appears.

2.	 On the Export tab, next to Export Patient File To, click Browse to select the location where you want to 
save the .html file (a human-readable format) and C-CDA file (an .xml file that is computer readable).

3.	 Under Document Type to Export, select Transition of Care For Referral (TC). Click the Related 
Referral search button  to select the referral (to) that you want to associate with the summary. The 
related referral is required for you to be able to export the summary.

Note: Under Export the following formats, the HTML (Human Readable) check box is always selected 
and cannot be cleared. Leave the XML (Data File) check box selected to have the file contain data in an 
XML format.

4.	 In the Note field, type any notes that you want to attach to the export. Notes are only for your reference 
and are not included in the text of the file.

5.	 Click Export.

A message appears when the export is complete.

6.	 Click OK.

Note: Each time a C-CDA file is exported, an entry is added to the History list on the Export tab. To view a 
file, select it, and then click View.
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Chapter 5: Quick Letters
With Quick Letters you can quickly generate a pre-determined form with patient information, Dentrix 
Enterprise will insert as much information as possible into the form, such as his or her name and CDCR 
number.

Note: To use this feature, Microsoft Word must be installed.

Quick Letter examples:
•	 CDCT-239_Prosthetic Rx, which is a Prosthetic Prescription
•	 CDCR-7225_D, which is a Refusal of Examination and/or Treatment
•	 CDCR-7423_RC, which is a Notification of Reception Center Dental Screening
•	 CDCR-7424, which is a Consent for Root Canal Treatment

Note: An outside report will be provided for all patients who are due for their Dental Exam. In Quick Letters, 
you can print the Exam Notification, so the notification is logged in the Office Journal.

To generate and print a quick letter

1.	 In Family File, Ledger, or Chart, with a patient selected (or in Appointment Book, with a patient’s 
appointment selected), click the Quick Letters button  on the toolbar.

The Quick Letters dialog box appears.

2.	 Select the letter that you want to print.
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3.	 Do one of the following:

•	 To create and print the letter without reviewing it, click Print.

•	 To create and review the letter in Microsoft Word prior to printing it, click Build/View.

Important: Use Build/View to add custom language to a letter, such as a refusal form or a written 
response, before printing it.

Note: Dentrix Enterprise adds an entry in Office Journal that indicates a letter has been sent to the 
patient.
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Chapter 6: Office Journal
With the Dentrix Enterprise Office Journal, you can do the following:

•	 Record contact among patients, providers, and staff

•	 Enter administrative notes

Dentrix Enterprise automatically adds entries in Office Journal for activities such as scheduling an 
appointment and printing Quick Letters.

To open a patient’s Office Journal, do one of the following:

•	 From any Dentrix Enterprise module (except Office Manager), select a patient, and then click the Office 

Journal button  on the toolbar.

•	 From Appointment Book, select a patient’s appointment, and then click the Office Journal button  
on the toolbar.

•	 From Office Manager, click the Office Journal button  on the toolbar; cancel the dialog box that 
prompts you to select a provider or staff member; from the View menu, click By Patient; and then select 
a patient.
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Viewing Office Journal Entries
Do any of the following:

•	 Click the Expand List button  to expand the list of entry dates to see more information.

•	 Click the Collapse List button  to collapse the list of entries to see only the entry dates.

•	 Click the View Filters button  to customize the view when viewing patient, provider, staff, or referral 
journal entries.

•	 Click the Hide/Show Info button  to show or hide additional information on the right side of the 
window for a selected entry.

Viewing Patient Journal Entries
You can display all the entries for a certain patient. Also, you can customize what types of entries are displayed 
in Office Journal.

To customize the view

1.	 If you are not viewing Office Journal by a patient name, from the View menu, click By Patient, and then 
select a patient.

2.	 From the View menu, click Filters.

The View Filters dialog box appears.

3.	 Set up the following view options:

•	 Select Journal Entry Types – Select the entry types you want to be displayed, or select All Journal 
Entry Types to view all entry types.

•	 Filter By – Click This Clinic if you want entries from the current clinic to be displayed, or All 
Clinics if you want entries from all clinics to be displayed.

•	 Entries Dated After – To only display items after a certain date, leave the default date, or type a 
different cut-off date.

4.	 Select Save as Default if you want to save the current settings for the next time you open Office Journal.

5.	 Click OK to return to Office Journal with the selected view settings.
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Viewing Provider or Staff Journal Entries
You can display entries for a specific provider or staff member. Also, you can customize what types of entries 
are displayed in Office Journal.

To customize the view

1.	 If you are not viewing Office Journal by a provider or staff member, from the View menu, click By 
Provider/Staff, and then select a provider or staff member.

2.	 From the View menu, click Filters.

The View Filters dialog box appears.

3.	 Set up the following view options:

•	 Select Journal Entry Types – Select the entry types you want to be displayed. For Phone Calls, 
Reminders, Miscellaneous, and HIPAA Privacy, you can select the accompanying Include Patient 
Entries check box to include all patient entries for any of those types, as well.

•	 Entries Dated After – To only display items after a certain date, leave the default date, or type a 
different cut-off date.

4.	 Select Save as Default if you want to save the current settings for the next time you open Office Journal.

5.	 Click OK to return to Office Journal with the selected view settings.
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Viewing Referral Journal Entries
You can display entries for a specific referral (inbound or outbound). Also, you can customize what types of 
entries are displayed in Office Journal.

To customize the view

1.	 If you are not viewing Office Journal by a referral, from the View menu, click By Referral By or By 
Referred To, and then select a referral.

2.	 From the View menu, click Filters.

The View Referral Filters dialog box appears.

3.	 Set up the following view options:

•	 Select Journal Entry Types – Select the entry types you want to be displayed, or select All Journal 
Entry Types to view all entry types.

•	 Select Provider/Staff – Select the providers and/or staff you want to view, or select For All Prov/Staff 
to view entries for all providers and staff

•	 Entries Dated After – To only display items after a certain date, leave the default date, or type a 
different cut-off date.

4.	 Select Save as Default if you want to save the current settings for the next time you open Office Journal.

5.	 Click OK to return to Office Journal with the selected view settings.
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Adding Office Journal Entries
You can manually add four types journal entries into Office Journal: Phone Call, Reminder, Misc, and 
HIPAA. These entries will include the date, time (except for reminders), and provider/staff members, and you 
can add a note.

To add a manual entry

1.	 In Office Journal, click the Add Journal Entry button  on the toolbar.

The Add Journal Entry dialog box appears.

2.	 Set up the following options:

•	 Type – SelectMiscellaneous.

•	 Prov/Staff – If you want to assign a provider or staff member to this journal entry, click the search 
button , and then select a provider or staff member.

•	 Description – Type a short description (up to 40 characters in length) for the journal entry.

•	 Note – Type a longer description (up to 4,000 characters in length) for the journal entry. Also, you 

can click the Check Spelling button  to check the spelling of the note text (this button is available 
only if a certain preference setting has been enabled).

•	 Date – If needed, change the date of the journal entry.

•	 Time – If needed, change the time of the journal entry.

3.	 Click OK.
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Editing Office Journal Entries
Automatic entries (for appointments, billing statements, etc.) cannot be edited, but if the security rights 
assigned to your user account allow it, you can edit manual journal entries.

To edit a manual entry

1.	 In Office Journal, expand an entry date item, and then select the manual entry that you want to edit.

2.	 From the Edit menu, click Edit.

The Edit Journal Entry dialog box appears.

3.	 Make any necessary changes:

•	 Prov/Staff – If you want to assign a different provider or staff member to this journal entry, click the 
search button , and then select a provider or staff member.

•	 Description – Type a new or change the existing short description (up to 40 characters in length) for 
the journal entry.

•	 Note – Type a new or change the existing longer description (up to 4,000 characters in length) for the 

journal entry. Also, you can click the Check Spelling button  to check the spelling of the note text 
(this button is available only if a certain preference setting has been enabled).

•	 Date – If needed, change the date of the journal entry.

•	 Time – If needed, change the time of the journal entry.

4.	 Click OK.
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Deleting Office Journal Entries
Payment, appointment, and payment agreement note entries cannot be deleted from Office Journal, but if the 
security rights assigned to your user account allow it, you can delete letters and manual journal entries.

To delete a manual journal entry

1.	 In Office Journal, expand an entry date item, and then select the manual entry that you want to delete.

2.	 From the Edit menu, click Delete.

A confirmation message appears.

3.	 Click the Yes to delete the entry.

Printing Office Journal Entries
You can print the entries currently being displayed in Office Journal.

Note: Dentrix Enterprise will print whatever entries are currently being displayed in Office Journal regardless 
of which entry dates are collapsed or expanded.

To print Office Journal entries

1.	 In Office Journal, from the File menu, click Print.

The Print dialog box appears.

2.	 Select a printer.

3.	 Set up any other options as needed, and then click OK.
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Chapter 7: Document Center
Document Center can help your office become paperless. You can scan, capture, and import documents 
(such as patient forms and referral letters) and images (such as patient pictures and X-rays). You can then 
attach these documents to patients, providers, employers, insurance plans, and referral sources. Also, these 
documents can be printed, emailed, or sent electronically (for claims).

A document in Document Center can be a document file type (.txt, .rtf, .doc, .docx, and .pdf ), an image file 
type (.bmp, .gif, .jpg, .png, and .tif ), a slide show presentation file type (.ppt. .pptx), a spreadsheet file type 
(.xls or .xlsx), or any other file type (which can be stored but not previewed in Document Center).

You can open Document Center from Family File, Ledger, Chart, Appointment Book, Treatment Planner, 
Collections Manager, and Office Manager by clicking the Document Center button  on the toolbar.

The Document Center window consists of a menu bar, toolbars, a document tree, a document thumbnails 
pane, a document preview area, and a document notes pane.

Document Thumbnails Document Preview Area

Document Tree Document Notes

Menu Bar Toolbars
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Scanning Documents
You can acquire documents and images in Document Center with a scanner or digital camera.

Document Center can store any important document or image that you may need to attach to a patient, 
provider, staff member, insurance carrier, employer, and/or referral.

To scan a document

1.	 In Document Center, from the From Device button  menu, click the appropriate device.

The corresponding third-party program opens.

2.	 Select the documents or images you want to acquire, and follow the program’s instructions for acquiring 
the document or image. The specific steps to complete this process depend on the device that you are 
using.

3.	 When the acquisition is complete, the Document Information dialog box appears. Enter the appropriate 
document information as explained in “Editing Document Information” in this chapter.

Importing Documents
You can import documents and images into Document Center from a file on your computer, another 
computer on your office’s network, a disc, an external drive, or a saved email attachment.

Important: Without encryption, transmitting patient health information by email is not secure. Refer to 
the CCHCS Information Security and Privacy for guidelines on sharing and transmitting patient health 
information.

Document Center can store any important document or image that you may need to attach to a patient, 
provider, staff member, insurance carrier, employer, and/or referral.

Important: Do not attach documents to providers, staff, or insurance carriers.

To import a document

1.	 In Document Center, click the Import from File button .

The Import dialog appears.
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2.	 Locate the directory where the file is stored, select the desired file, and then click Open.

3.	 When the acquisition is complete, the Document Information dialog box appears. Enter the appropriate 
document information as explained in “Editing Document Information” in this chapter.

Printing Documents
Document Center provides the following ways to print documents:

•	 Print the Document Center List – The Document Center List consists of the contents in the document 
tree for the current view. It will list all attached documents, according to the filters selected. In the 
Document Center, from the File menu, point to Print, and then click Document Center List.

•	 Print documents – You can print a specific document or multiple documents. In the Document Center 
document tree, select the documents you want to print. Then, from the File menu, point to Print, and 
then click Print Document(s).

Editing Document Information
You can edit the date, type, description, note, attachments, and signatures assigned to a document as long as 
the document has not been signed. Once a document has been signed, you cannot change that document’s 
date, type, description, or note, but you can attach more sources to it.

To edit document information

1.	 In the Document Center document tree, select the document that has information you want to edit.

2.	 Click the Document Information button .
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The Document Information dialog box appears.

3.	 Make the necessary changes to any of the following options:

•	 Reference Date – By default, the date of the document is the current system date, but you can 
change it as needed to reflect the correct date of service (dental encounter). This date will appear for 
this document in the document tree and when it is printed.

•	 Document Type Template – Select the template that corresponds to the type of document being 
added. The Document Type and Description will be populated automatically based on the selected 
template.

Notes:

•	 Each template corresponds to a CDCR form number. Use the Outside Provider template when 
you are adding non-CDCR documents (such as clinical notes or oral surgery notes) from outside 
providers.

•	 The Document Type and Description associated with each template are configured to match the 
setup in PowerChart, so do not change them in the Document Information dialog box.

•	 If a template needs to be changed or a new one added, create a ticket in Solution Center.

•	 Document Type – The type is determined by the selected Document Type Template. Do not change 
the type.

•	 Description – The description is determined by the selected Document Type Template. Do not 
change the description. This description will appear for this document in the document tree and be 
used as a file name for the document when the document is exported or attached to an email message.

Important: Without encryption, transmitting patient health information by email is not secure. 
Refer to the CCHCS Information Security and Privacy for guidelines on sharing and transmitting 
patient health information.

•	 Note – Type any pertinent notes regarding the document. The note text will be appended 
automatically to the text of an email message with this document attached, and you can view the note 
when previewing this document.
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•	 Modify Attachments – To associate the document with a patient, provider/staff, employer, insurance 
plan, and/or referral other than the current patient, provider/staff, employer, insurance plan, or 
referral currently being viewed in Document Center, click this button. For more information about 
document sources, see “Modifying Document Attachments” in this chapter.

Note: If you are acquiring from the Document Center printer driver or the Document Center 
Unfiled Documents window, by default, the document does not have any attachments associated 
with it.

4.	 Click OK.

Modifying Document Attachments
If the security rights assigned to your user account allow it, you can modify attachment sources for a specific 
document as needed (for example, to transfer a document that was scanned into the wrong patient’s record 
to the correct patient’s record). You can associate a document with a patient, provider/staff, employer, dental 
insurance plan, medical insurance plan, inbound referral, and/or outbound referral. Also, you can assign 
additional sources to a document that has been signed.

To modify a document’s attachments

1.	 In the Document Center document tree, select a document.

2.	 Click the Modify Document Attachments button .

The Modify Document Attachments dialog box appears.
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3.	 Make the necessary changes:

•	 Attach Document By – For each entity that you want to attach to the document, click the 
corresponding entity’s search button , and make your selection:

•	 Patient – In the Select Patient dialog box that appears, select a patient.

•	 Provider/Staff – In the Select Provider/Staff dialog box that appears, select the desired provider 
or staff member.

•	 Dental Insurance Plan – In the Select Dental Insurance Plan dialog box that appears, select 
the desired insurance plan.

•	 Medical Insurance Plan – In the Select Medical Insurance Plan dialog box that appears, select 
the desired insurance plan.

•	 Referred BY – In the Select Referred By dialog box that appears, select the desired referral 
source.

The attachment associations appear in the Document Attachments list box.

•	 Remove Attachment – To remove an attachment, select it in the Document Attachments list box, 
and then click Remove Attachment.

4.	 Click Close.

Deleting Documents
If the security rights assigned to your user account allow it, you can delete a document as needed. Dentrix 
Enterprise will not delete the original document from the computer but will remove it from Document 
Center.

To delete a document

1.	 In the Document Center document tree, select the document you want to delete.

2.	 Click the Delete Selected Document(s) button .

Do one of the following:

•	 If the document has multiple attachment sources, a dialog box appears. Select whether you want to 
delete the document for only the current attachment source being viewed in the Document Center or 
delete the document for all attachment sources, and then click OK.

•	 If the document is attached to only the source being viewed in Document Center, a confirmation 
message appears. Click OK.
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Signing Documents
You can apply signatures to a document attached only to patients, providers, and/or staff. You can apply a 
signature to a document for each patient, provider, or staff member attached to the document.

Important: Once a document has been signed, you cannot change the document information, but you can 
attach the document to additional sources.

To sign a document

1.	 In the Document Center document tree, select the document you want to sign.

2.	 Click the Sign Document button . (If the selected document already has at least one signature, the 

button looks different. )

The Sign Document dialog box appears.

3.	 The Name field automatically displays the patient, provider, or staff member selected in Document 
Center, but you can change the name as needed.

4.	 Use a mouse or other supported device to add your signature in the Signature box. If you need to erase 
the signature so that you can re-sign, click Clear.

5.	 Click OK.
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Chapter 8: Appointment Book
Appointment Book provides tools to help you navigate through the schedule, search for open times, and 
manage appointments. Typically, you will identify appointment needs and schedule appointments from 
Treatment Request Manager and Scheduling Assistant. However, in Appointment Book, you can record 
broken appointments and print the schedule.

Appointment Book is divided into the menu bar, calendar, time bar, provider color bar, date bar, operatory 
ID, toolbar, navigation buttons, pin board, day view, week view, month view, and flip tabs.

Calendar Provider Color Bar Date Bar Operatory IDTime Bar

Navigation
Buttons

Pin Board

Day View

Week View

Month View

Flip Tabs

Since most appointments will be made with a couple of days of receiving a treatment request, you can use the 
navigation buttons to navigate to the correct date.

To search for an open time for a particular day of the week or time, click the Find New Appointment Time 

button  on the toolbar.
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The Appointment Book Toolbar
The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

The function of each button on the toolbar is explained in the following table.

Button Name Description

 More Information Opens the More Information window of the patient scheduled for 
the selected appointment.

 Patient Chart Opens the Patient Chart of the patient scheduled for the selected 
appointment.

 Family File Opens the Family File of the patient scheduled for the selected 
appointment.

 Ledger Opens the Ledger of the patient scheduled for the selected 
appointment.

 Office Manager Opens the Office Manager module.

 Quick Letters Opens the Quick Letters dialog box.

 Prescriptions Opens PowerChart.

 Office Journal Opens the Office Journal of the patient scheduled for the selected 
appointment.

 Document Center Opens the Document Center of the patient scheduled for the 
selected appointment.

 Message Center Opens the Cerner Message Center.

 Break Appointment Opens the Break Appointment dialog box to select a reason for 
breaking the selected appointment.

 Schedule Appointment Opens the Select Patient dialog box to select a patient, and then 
the New Appointment Information dialog box opens.

 
Find New Appointment 
Time

Opens the Find New Appointment Time dialog box to find an 
available appointment time by entering search criteria.

 Locate Appointment Opens the Select Patient dialog box to select a patient, and then 
the Appointments dialog box appears.

 Set Complete Opens the Set Appointment Procedures Complete dialog box.

 Delete Appointment Deletes the selected appointment.

 Medical Alerts Opens the Medical Alerts window of the patient scheduled for the 
selected appointment.

 Clinical Notes Opens the Clinical Notes window of the patient scheduled for the 
selected appointment.

 Patient Health Exchange Opens the Patient Health Exchange dialog box of the patient 
scheduled for the selected appointment.
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Button Name Description

DXOne Reports Click to open DXOne Reporting to generate and manage reports.

Signature Manager Click to open the Signature Manager dialog box to sign multiple 
clinical notes at one time.

Scheduling Assistant Click to open the Scheduling Assistant window, which can help 
enhance your scheduling workflow.

Scheduling Appointments for 
Treatment Requests
You can schedule an appointment for treatment requests from the Treatment Request Manager. For 
information about using Treatment Request Manager, see Chapter 1: Treatment Request Manager.

Tip: You can also schedule appointments for existing treatment requests from Scheduling Assistant. For 
information about using the Scheduling Assistant, see Chapter 3: Scheduling Assistant.

Note: When scheduling an appointment for a treatment request, the treatment request will automatically be 
attached to the appointment. If the appointment requires additional treatment requests, you can attach those 
requests, too.

To schedule an appointment for a treatment request

1.	 Do one of the following:

•	 In the Edit - Treatment Request (or New - Treatment Request) dialog box, click Create Appt.
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•	 With one or more treatment requests selected in Treatment Request Manager, click the Create 

Appointment button . This button is available only if at least one request is selected.

Note: You cannot create an appointment for a treatment request with a Canceled or Completed status.

The Select View dialog box appears. Also, Appointment Book opens in the background if it is not already 
open.

2.	 Select an Appointment Book view.

3.	 Click either Select or OK.
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The New Appointment Information dialog box appears.

Note: The treatment request is linked to the appointment automatically along with the patient’s provider.

The status of the linked treatment request changes to Scheduled automatically.

4.	 Set up the appointment details, such as the provider, encounter number, and reason.

Note: The encounter number is required because it is used to send the clinical notes over to Millennium.

5.	 Use one of the following methods to find an available time slot for the appointment:

•	 Pinboard: (This is the preferred method since appointments are not pre-booked more than a few days 
in advance.)

a.	 Click Pin Board.

b.	 Navigate to the desired date for the appointment, and then drag the patient’s appointment from 
the Pinboard to the desired time slot in the correct operatory.

c.	 On the confirmation message, click Yes.
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•	 Find New Appointment Time tool:

a.	 Click Find.

The Find New Appointment Time dialog box appears.

b.	 Set up the following options:

•	 Select Provider(s) – Select the providers whose availability you want to search for. By 
default, the providers assigned to the current view being used in Appointment Book appear 
in the list.

•	 Select Op(s) – Leave Select All Ops selected to search for open times in all operatories, or 
deselect the operatories that you do not want to search for open times in. By default, the 
operatories assigned to the current view being used in Appointment Book appear in the list.

•	 Providers/operatories in – By default, View is selected, and the providers and operatories 
assigned to the current view being used in the Appointment Book appear in the Select 
Provider(s) and Select Op.(s) lists. To display providers and operatories assigned to 
a different view, select the desired view from the list. Or, to display the providers and 
operatories for the clinic that you are currently logged in to, select Clinic.

If you change the current selection under Providers/operatories in, you must make new 
selections in the Select Provider(s) and Select Op.(s) lists.

•	 Select Days – Select the days of the week that you want to include in the search.

•	 Start Date – Enter the date from which you want to start searching, or click the search 
button  to select the date from a calendar. By default, this is today’s date.

Note: Alternatively, to advance the Start Date by a specified interval relative to the date 
currently entered, select an interval type (Day(s), Week(s), or Month(s)), and then click a 
number button. For example, if you want to look for an available appointment time starting 
six months from today, click Month(s) and then 6 to advance the starting date by six 
months.

•	 Appt Length – Leave the default length selected, or click the search button  to set the 
amount of time needed for the appointment. You can also indicate a time pattern: chair 
(blank), assistant (/), and provider (X) time.

•	 No Duplicate Operatory Times – If the search finds the same open time in multiple 
operatories on a given date, and you want only the first of those duplicate times to be listed, 
select this check box.



Chapter 8: Appointment Book    67

Dentrix Enterprise 11.0.48 Learner’s Guide

c.	 Click Search/View.

The Available Appointment Times dialog box appears and lists the first 10 available times that 
match your search criteria.

d.	 Select the date and time that you want to preview in Appointment Book, and then click View. 
Appointment Book displays that date and outlines that time.

Tip: If none of the 10 displayed dates and times will work, click More to list the next 10 available 
dates and times.

e.	 To use the selected date and time to schedule the appointment, click Select; otherwise, click 
Cancel to change your search criteria.

Notes: 

•	 All appointments must have a yellow E on them. This denotes that insurance has been attached to the 
patient’s record (refer to step 5c).

•	 If you schedule a patient and the appointment color is white, the provider chosen for this appointment 
has not be sent up correctly. To resolve the issue, create a ticket in Solution Center.
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Linking Treatment Requests to 
Appointments
If a patient already has an appointment scheduled to which you need to link a treatment request, you can link 
that treatment request to that existing appointment. You can link multiple requests to one appointment, but 
you cannot link a request to multiple appointments.

To link a treatment request to an appointment

1.	 In Appointment Book, double-click an appointment.

The Appointment Information dialog box appears.

2.	 Click the Tx Request search button .
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The Select Treatment Request dialog box appears.

3.	 Select the treatment requests that you want to link to this appointment. To select multiple requests, while 
pressing Ctrl, click the desired requests. Only treatment requests that have been created for the patient 
whose appointment you are viewing are available. Also, if a selected request is already linked to another 
appointment, you will be asked if you want to unlink the request from its current appointment and link 
the request to this appointment.

Note: You cannot attach a treatment request with a Canceled or Completed status to an appointment.

4.	 Click OK.

The status of any linked treatment requests changes to Scheduled automatically.

5.	 In the Appointment Information dialog box, click OK.
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Breaking Appointments
When a patient doesn’t show up for or cancels his or her appointment, or, if for some reason, your office has 
to cancel the appointment, you can break the appointment. To prevent these broken appointments from 
being forgotten, Dentrix Enterprise moves them to the Unscheduled List, where they can be reviewed on a 
regular basis. When you break an appointment, Dentrix Enterprise moves all of the entered information to 
the Unscheduled List so that you don’t have to re-enter it later. The appointment remains on the Unscheduled 
List until you reschedule it.

Also, when you try to schedule an appointment for a patient with a broken appointment, Dentrix Enterprise 
displays a message that states that the patient has a broken appointment and prompts you to reschedule it.

To break an appointment

1.	 In Appointment Book, select the appointment.

2.	 Do one of the following:

•	 If ducats have already been produced, or if it is past the ducat cut-off time, break the appointment:

a.	 With the appointment selected, click the Break Appointment button  on the toolbar.

The Break Appointment dialog box appears.

b.	 Select the Reason that corresponds to the broken appointment code that you entered in the 
Patient Chart.

c.	 Click OK.

Note: Dentrix Enterprise moves the appointment from Appointment Book to the Unscheduled List 
and updates the last missed appointment information in Family File to reflect the date the patient 
broke the appointment and the number of times the patient has broken appointments. Also, Dentrix 
Enterprise automatically adds an entry in the patient’s Office Journal.

•	 If you are going to reschedule the appointment immediately, do so as explained in “Moving 
Appointments” in this chapter.
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Moving Appointments
You can quickly move an appointment to a new day, time, and/or operatory as needed.

•	 By dragging (same day):

1.	 In Appointment Book, click and drag the appointment to a new time and/or operatory.

2.	 On the confirmation message that appears, click OK.

•	 With the Pinboard (same day or different day):

1.	 In Appointment Book, click and drag the appointment to the Pinboard.

Tip: To return an appointment on the Pinboard to its original time and operatory, from the File 
menu, click Refresh.

2.	 Once you find a new day, time, and/or operatory for the appointment, click and drag the 
appointment to the desired spot on the schedule.

3.	 On the confirmation message that appears, click OK.

Changing the Status of an 
Appointment
You can change an appointment’s status to track the stages of the corresponding patient’s visit.

Note: When the patient arrives on site, you will change his or her appointment status to Here. This will 
change the color of the bar on the left side of the appointment to blue to visually indicate to the staff that the 
patient has arrived for his or her appointment.

To change an appointment’s status

1.	 In Appointment Book, select the appointment.

2.	 From the Status menu, select a status.
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Working with ASAP Appointments
With Dentrix Enterprise, you can flag scheduled appointments as ASAP (As Soon As Possible). Once you 
have flagged an appointment as ASAP, it appears on the ASAP List.

Note: Since you will rarely pre-book dental appointments, you will likely not flag appointments as ASAP very 
often. However, there may be a scenario where an oral surgeon needs to schedule an additional day or a lab 
case comes in early; in which case, you may want to flag the patient’s appointment as ASAP to put him or her 
on a quick call list.

To flag an appointment as ASAP

While scheduling or editing an appointment, in the New Appointment Information or Appointment 
Information dialog box, select ASAP from the Schedule list.

To schedule an ASAP appointment

1.	 In Scheduling Assistant, select ASAP Appointments to view appointments that have been marked as 
ASAP. For more information about opening and filtering the Scheduling Assistant list, see Chapter 3: 
Scheduling Assistant.

2.	 Locate an ASAP appointment, and verify that the patient is available.

3.	 Reschedule the ASAP appointment as explained in “Scheduling Appointments from the Scheduling 
Assistant” in Chapter 3: Scheduling Assistant.

Printing the Appointment Book View
The Appointment Book View Report shows your daily schedule.

To print the Appointment Book View Report

1.	 In Appointment Book, from the File menu, click Print Appointment Book View.

The Select View dialog box appears.
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2.	 The current view in Appointment Book determines the default settings for the report, but you can change 
any of the following options as needed:

•	 Select Provider(s) – Select up to 10 providers to include on the report.

•	 Select Op(s) – Select up to 10 operatories to include on the report.

•	 Date – By default, the current date is used as the date for which the schedule will be printed, but you 
can type a new date in the Date field or click the search button  to select a date.

•	 Appointment Display Info – Depending on the length of an appointment, up to nine lines of 
information can be displayed on the face of an appointment. For each Line, select the information 
you want to have displayed on that line, or select [None] to leave that line blank.

•	 View Options – Select any of the following:

•	 Print Amount – To print the scheduled production amount for the day, week, or month.

•	 Print Appt Colors – To print in color if you are using a color printer instead of in grayscale.

•	 Print Day Note – To print the Appointment Book day note for the date being printed.

•	 Print Perfect Day – To print the perfect Day Scheduling time blocks.

•	 Print Time at Right – To include the time bar on the right side of the appointments in addition 
to the time bar along the left side.

•	 Time View – Type the earliest hour of appointments that you want to print in the Start Hr field. 
Type the latest hour of appointments that you want to print in the End Hr field. Click am or pm 
for both fields.

3.	 If you want to save the current settings for the next time you print the Appointment Book View, click 
Save Print View. Only one Appointment Book View per computer can be saved.

4.	 Click Print to print the report to the default printer for Office Manager, or click Batch to send the report 
to the Batch Processor in Office Manager.

Completing Appointments
You will post/charge procedures from Appointment Book by marking patients’ appointments as “Complete.” 
When you are completing an appointment, you can choose to post the procedures attached to that 
appointment to Ledger and Chart.

To complete an appointment

1.	 In Appointment Book, locate the appointment. If the appointment’s provider and/or reasons do not need 
to be changed, select it. (Skip step 2.)

2.	 If the appointment’s provider and/or reasons need to be changed, do the following to edit the 
appointment:

a.	 Double-click the appointment.
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The Appointment Information dialog box appears.

b.	 Make any necessary changes to the Prov or Reason as needed.

Notes:

•	 If the appointment requires a $5.00 co-pay, click Initial to select Co-Pay Visit as an appointment 
reason.

•	 If the patient has refused treatment, remove any treatment that has not been completed, and then 
click Initial to select Patient Refusal as an appointment reason.

c.	 Click OK.

3.	 Click the Set Complete button  on the toolbar.

The Set Appointments Complete dialog box appears.

Notes:

•	 All procedures attached to the appointment are selected. If a procedure has not been completed on 
this visit, deselect that procedure.

•	 For prosthetic procedures, the ADA code will be charged out with the Final Impression. If there is a 
Preliminary Impression first, that will be no charge. At the final impression appointment, the ADA 
code and in-house code for the Final Impression will be charged out.
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•	 For after-hours emergency visits, in addition to the ADA codes being posted, the ADA code of 
D9440 (Office visit-after regular hrs.) will be posted.

•	 If a procedure that requires additional treatment information (such as a tooth number or surface) has 
been attached to the appointment (by clicking Misc. in the New Appointment Information dialog 
box), that procedure will not be set complete. Deselect it. You will have to post it to the patient’s 
Chart or Ledger separately, specifying the appropriate treatment areas.

3.	 Click Set Complete.

Dentrix Enterprise posts the procedures to Chart and Ledger, and the appointment in Appointment Book 
becomes gray to indicate that the appointment has been completed.

Notes:

•	 The goal is to have all appointments grayed out or rescheduled by the end of the day.

•	 Each patient’s Dental Priority Classification (DPC) should be confirmed and, if needed, edited. This can 
be done when the patient’s clinical note is signed.

Editing Appointments
You change the provider and/or reasons pertaining to an appointment if those options need to be changed 
when you are completing that appointment. For information about how to complete an appointment, see 
“Completing Appointments” in this chapter.

Unlinking Treatment Requests
If you need to unlink a treatment request from an appointment, you can do so from the corresponding 
patient’s More Information window. For information about how to unlink a treatment request, see 
“Managing Treatment Requests” in Chapter 2: More Information Window.
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Deleting Appointments
You can permanently delete an appointment from the Appointment Book. The only time you should delete 
an appointment for patient of record is if you scheduled the appointment for the wrong patient or the 
appointment should not have been scheduled in the first place.

Note: When you delete an appointment, Dentrix Enterprise makes an entry in the audit trail, indicating the 
date and time you deleted the appointment.

To delete an appointment

1.	 In Appointment Book, select the appointment.

2.	 Click the Delete Appointment button  on the toolbar.

A confirmation message appears.

3.	 Click Yes.

Note: If a treatment request was attached to the appointment, the status of that treatment request changes 
automatically according to the following criteria:

•	 With a reviewing provider selected, the status changes to Reviewed.

•	 Without a reviewing provider selected, the status changes to Received.
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Scheduling Events
Appointment Book is not just for managing patient appointments. It also allows you to schedule events, such 
as staff meetings, vacations, and activity reminders. You can use an event to block out time or close one or all 
operatories in Appointment Book, so you have a visual reminder that you cannot schedule during that time. 
An event can be for a single day or be a recurring event for up to one year.

To schedule an event or a series of events

1.	 In Appointment Book, navigate to the starting date of the event, right-click in the desired operatory at 
the desired starting time for the event, and then click Schedule Event.

The Schedule Event dialog box appears.
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2.	 Set up the following options:

•	 Time, Days, Operatories – By default, Dentrix Enterprise uses the operatory, date, and time for the 
event that corresponds to the time slot where you right-clicked to begin scheduling this event. You 
can change the Event Time, Event Days, and/or Operatories as needed. If the event will last the 
entire day, select Close Operatory (All Day Event).

Notes: 

•	 You must select at least one day. If the event starts and ends on the same day, select that day of 
the week. 

•	 You cannot schedule an event that overlaps a scheduled appointment or another event.

•	 Description – Type a description for the event or series. To center the description horizontally at the 
top of the event block in Appointment Book, select Center Description on Scheduled Event. With 
this check box cleared, the description is left aligned.

•	 Event Color – Click the button to choose a color for the event.

Tip: When choosing a color for the event, choose a light color that contrasts with the black text 
of the event description, so you can see the words easily. For example, black text will not be easily 
readable on a dark blue background.

•	 Notes – Type any notes that apply to the event.

Important: If you create a repeating event, be aware that if you want to delete the whole series, you must 
delete each event in that series one at a time.

3.	 Click OK.

Notes:

•	 The event creation process may take several minutes, depending on the date range specified, the days 
of the week selected, the number of operatories selected, and the number of future appointments 
scheduled.

•	 If you attempt to schedule a single event that overlaps with an existing appointment or event, a 
message appears and states that the operatory is already scheduled at the requested time.

•	 If Dentrix could not create an event that is part of a series because that event overlaps with an existing 
appointment or event, a log file appears for your reference. You can correct the conflicts and then 
schedule events to match those in the series you created previously.
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Rescheduling Events Using the 
Pinboard
You can use the Pinboard to quickly reschedule an event.

To reschedule an event using the Pinboard

1.	 Drag a partial-day or all-day event to the Pinboard.

A copy of the event appears as an event icon on the Pinboard.

2.	 Drag the icon from the Pinboard to the desired date, time, and operatory.

Editing Events
You can edit an event’s details as needed. If the event is part of a series (an event that repeats at regular 
intervals), only the occurrence you are editing is affected.

To edit an event

1.	 In Appointment Book, double-click the event you want to edit.

The Edit Event dialog box appears.
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2.	 Edit the various event options as needed. For information on setting up event options, see “Scheduling 
Events” in this chapter.

3.	 Click OK.

Deleting Events
You can delete a single event or an event that is part of a series. You cannot delete a whole series of events at 
one time; you must delete each occurrence separately.

To delete an event

1.	 In Appointment Book, double-click the event you want to delete.

The Edit Event dialog box appears.

2.	 Click Delete. On the confirmation message that appears, click Yes.
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Chapter 9: Chart
Chart is the clinician’s working chart for the patients’ clinical treatment information. Clinical staff will 
enter existing dental restorations, current conditions, and completed treatment. You can access Perio Chart, 
Treatment Planner, and Clinical Notes from Chart.

The Chart window consists of the menu bar, toolbar, graphical chart, procedure buttons, procedure code 
category buttons, status buttons, and progress notes.

Graphical Chart

Procedure Buttons Procedure Code Category Buttons

Status Buttons

Progress Notes

Note: On the title bar, when you have a patient selected, you will be able to view the patient’s name, clinic, 
appointment provider, CDCR number, date of birth, age, bed, TABE score, EPRD and DPC code.
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The Chart Toolbar
Chart includes a toolbar to provide easy access to most of the charting tools and other areas of Dentrix 
Enterprise.

The function of each button on the toolbar is explained in the following table.

Button Name Description

More Information Opens the selected patient’s More Information window.

Family File Opens the selected patient’s Family File.

Ledger Opens the selected patient’s Ledger.

Appointment Book Opens the Appointment Book module.

Office Manager Opens the Office Manager module.

Quick Letters Opens the Quick Letters dialog box.

Continuing Care Opens the selected patient’s Continuing Care list.

Prescriptions Opens PowerChart.

Office Journal Opens the selected patient’s Office Journal.

Document Center Opens the selected patient’s Document Center.

Patient Education Opens the Patient Education dialog box.

Select Patient Opens the Select Patient dialog box to select a patient.

Print Dental Chart Prints the patient chart.

Work Chart Displays the work chart view.

Full Screen Chart Displays the fullscreen chart view.

Progress Notes Expands the Progress Notes panel to fill the window.

Treatment Planner Opens the selected patient’s Treatment Planner.

Perio Chart Opens the selected patient’s Perio Chart.

Medical Alerts Opens the selected patient’s Medical Alerts window.
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Button Name Description

Patient Health Assessment Opens the Patient Health Assessment dialog box.

Orders Opens the Orders dialog box.

Clinical Notes Opens the selected patient’s Clinical Notes window.

MiPACS Opens MiPACS.

Patient Health Exchange Opens the selected patient’s Patient Health Exchange dialog box.

DXOne Reports Click to open DXOne Reporting to generate and manage reports.

Signature Manager Click to open the Signature Manager dialog box to sign multiple 
clinical notes at one time.

Scheduling Assistant Click to open the Scheduling Assistant window, which can help 
enhance your scheduling workflow.

Opening Chart
You can open Chart from Appointment Book.

To open a patient’s Chart

1.	 In Appointment Book, double-click the patient’s appointment.
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The Appointment Information dialog box appears.

2.	 Verify that the treating provider is correct. If not, click the Prov search button  to select the correct 
provider.

3.	 Click OK.

4.	 With the patient’s appointment still selected, click the Patient Chart button  on the toolbar.
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Handling Global Alerts
Global alerts, which are attached to problems, allergies, and medications (PAM), will appear mainly when you 
open Chart. For example, for a patient who is allergic to Penicillin, not only will the Medical Alert icon be a 
red cross, but an a notification will appear when you open his or her Chart.

To handle a global alert

When a notification appears, select the Do not show this alert again today check box to suspend the alert for 
this patient for today only, and then click OK to dismiss the message.

Assigning Encounter Numbers
If Chart is the first area you open for a patient during his or her visit, you must assign an encounter number 
to the patient’s visit. This encounter number is used to send the clinical notes over to Millennium.

To assign an encounter number

1. Open a patient’s Chart.

The Encounter Required dialog box appears.

2.	 Click the Encounter# search button .
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The Select Encounter Number dialog box appears.

Note: Typically, Dentrix Enterprise will show only the encounters that are currently open in Millennium. 
If there are multiple encounters listed, make sure you select the encounter that you want your clinical 
note attached to. For example, for an inpatient visit, you should select the inpatient encounter. To verify 
which is the correct encounter, open Millennium.

3.	 Select the encounter number to attach to this visit, and then click OK.

4.	 Click OK.

Changing the Provider for a Charting 
Session
When you open a patient’s Chart, the appointment provider’s name should appear on the title bar. If the 
provider displayed is not the treating provider, select the correct provider.

To change the provider for a charting session

1.	 In Chart, with a patient selected, from the File menu, click Change Provider.

The Select Provider dialog box appears.

2.	 Select the provider to whom all work posted during this session should be assigned.

3.	 Click OK.

Note: You can change the provider for an individual procedure by editing it after it has been posted.
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Posting a Code for No Screening
For a patient who is not in need of an RC screening, you must post the in-house code “No RC Screening 
Needed” and enter a clinical note that explains why the RC screening is not needed.

Note: This is for rare cases when a dentist administratively completes an RC Screening as outlined in IDSP/P.

To post a code for no screening

1.	 In Chart, with a patient selected, make sure the appointment provider’s name appears on the title bar. If 
not, change the provider as explained in “Changing the Provider for a Charting Session” in this chapter.

2.	 Click the In-House procedure code category button.

The Select Procedure Code dialog box appears.

3.	 Double-click C0004   No RC Screening Needed.

4.	 Click Comp.

5.	 To create the clinical note that explains why the RC screening is not needed, do the following:

a.	 Click the Clinical Notes button  on the toolbar to open Clinical Notes.

b.	 Expand the Administrative template category, and then double-click the RC Screening template.

c.	 Answer the prompts that appear.

Notes:

•	 This clinical note will appear in the Signature Manager for signing.

•	 For more information about entering a clinical note, see “Entering Clinical Notes Using Templates” 
in Chapter 11: Clinical Notes.
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Verifying and Editing PAM Data
You must confirm and/or edit a patient’s problems, allergies, and medications (PAM) in PowerChart.

To open PowerChart, with a patient selected in Chart, click the Prescriptions button  on the toolbar.

Verifying Patient Health Assessments
A patient health assessment (PHA) is an electronic record of a patient’s vitals (height, weight, blood pressure, 
and so forth). A patient’s health assessment will be entered into PowerChart, and you can view it in Dentrix 
Enterprise.

To view a patient’s health assessments, with a patient selected in Chart, click the Patient Health Assessment 

button  on the toolbar.

The Patient Health Assessment dialog box appears.

Entering Prescription Orders
You can add a new order for a prescription in PowerChart. After the order is placed, and the medication has 
been verified by the pharmacy, the prescription can be seen in Dentrix Enterprise.

To open PowerChart, with a patient selected in Chart, click the Prescriptions button  on the toolbar.
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Viewing Lab Orders
You can view lab orders (for example, blood tests, biopsies, and cultures) for a patient in Chart.

To view lab orders, with a patient selected in Chart, click the Orders button  on the toolbar.

The Orders dialog box appears.

Accessing MiPACS Imaging Software
You can access the MiPACS imaging software from Chart to view a patient’s digital images stored in that 
program.

To open MiPACS, with the patient selected in Chart, click the MiPACS button  on the toolbar.

Changing Dentition in Chart
By default, Chart is set to show all teeth as permanent for patients. However, you can change the dentition for 
specific teeth on a patient-by-patient basis.

Important: Do not change to default setting.

To change the dentition

1.	 In Chart, with a patient selected, select the teeth whose dentition you need to change to primary.

2.	 From the Prim/Perm menu, click Change Selected.
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Charting Conditions
You can chart a condition, such as an open contact, caries, or a missing tooth, to help create an accurate 
representation of the patient’s oral cavity in the graphical chart.

Tip: To chart all conditions as a group, before you start charting, click the Auto-State button (+), and then 
click EO. After you finish charting conditions, click the Auto-State button (-) again to turn off auto-state, or 
click a different status button to chart treatment with the corresponding status.

To chart a condition

1.	 In Chart, with a patient selected, make sure the appointment provider’s name appears on the title bar. If 
not, change the provider as explained in “Changing the Provider for a Charting Session” in this chapter.

2.	 If the condition you are entering requires a tooth number, select the appropriate tooth/teeth in the 
graphical chart.

3.	 Click the Conditions procedure code category button, and then double-click a condition.

4.	 Do one of the following:

•	 If the selected condition requires the selection of quadrants, sextants, or arches, the Quadrant 
Selection, Sextant Selection, or Arch Selection dialog box appears. Select the applicable treatment 
areas, and then click OK.
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•	 If the selected condition requires the selection of surfaces, the Surface Selection dialog box appears. 
Do one of the following:

•	 If one tooth is selected:

a.	 Select the applicable treatment areas.

b.	 Click OK.

•	 If multiple teeth are selected:

a.	 With the first tooth selected in the list on the left, select the check boxes of the applicable 
surfaces, and then click Add.

b.	 Do one of the following for the other teeth listed:

•	 To apply the specified surfaces to all the other teeth listed, click Apply to all teeth. On 
the confirmation message that appears, click either Yes to apply the surfaces to all the 
teeth listed (you can change the surfaces of any tooth as needed before you click OK) or 
No to apply the surfaces to only the selected tooth (you must then add surfaces to each 
tooth separately before you click OK).
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•	 To add surfaces to each tooth separately, select a different tooth in the list on the left, 
select the check boxes of the applicable surfaces, and then click Add. Repeat this process 
as needed for the other teeth listed.

Notes:

•	 You can also change the surfaces for any tooth in the list by selecting that tooth.

•	 To continue, every tooth in the list must have at least one surface applied.

c.	 Click OK.

5.	 Click the EO status button.

Charting Existing Treatment
You can chart existing treatment, such as a restoration, to help create an accurate representation of the 
patient’s oral cavity in the graphical chart.

Tip: To chart all existing treatment as a group, before you start charting, click the Auto-State button (+), and 
then click EO. After you finish charting existing treatment, click the Auto-State button (-) again to turn off 
auto-state, or click a different status button to chart treatment with the corresponding status.

To chart an existing treatment

1.	 In Chart, with a patient selected, make sure the appointment provider’s name appears on the title bar. If 
not, change the provider as explained in “Changing the Provider for a Charting Session” in this chapter.

2.	 If the existing treatment you are entering requires a tooth number, select the appropriate tooth/teeth in 
the graphical chart.
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3.	 Specify the procedure by using a procedure button, a procedure code category button, or the Procedures 
menu.

4.	 Do one of the following:

•	 If the selected procedure requires the selection of quadrants, sextants, or arches, the Quadrant 
Selection, Sextant Selection, or Arch Selection dialog box appears. Select the applicable treatment 
areas, and then click OK.

          

•	 If the selected procedure requires the selection of surfaces, the Surface Selection dialog box appears. 
Do one of the following:

•	 If one tooth is selected:

a.	 Select the applicable treatment areas.

b.	 Click OK.

•	 If multiple teeth are selected:

a.	 With the first tooth selected in the list on the left, select the check boxes of the applicable 
surfaces, and then click Add.
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b.	 Do one of the following for the other teeth listed:

•	 To apply the specified surfaces to all the other teeth listed, click Apply to all teeth. On 
the confirmation message that appears, click either Yes to apply the surfaces to all the 
teeth listed (you can change the surfaces of any tooth as needed before you click OK) or 
No to apply the surfaces to only the selected tooth (you must then add surfaces to each 
tooth separately before you click OK).

•	 To add surfaces to each tooth separately, select a different tooth in the list on the left, 
select the check boxes of the applicable surfaces, and then click Add. Repeat this process 
as needed for the other teeth listed.

Notes:

•	 You can also change the surfaces for any tooth in the list by selecting that tooth.

•	 To continue, every tooth in the list must have at least one surface applied.

c.	 Click OK.

5.	 Click the EO status button.

Charting Treatment Needs
You can chart work that needs to be completed (treatment-planned).

Tip: To chart all treatment needs as a group, click the Auto-State button (+), and leave the Treat Plan button 
depressed. After you finish charting treatment needs, click the Auto-State button (-) again to turn off auto-
state.

To chart a treatment need

1.	 In Chart, with a patient selected, make sure the appointment provider’s name appears on the title bar. If 
not, change the provider as explained in “Changing the Provider for a Charting Session” in this chapter.
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2.	 If the treatment need you are entering requires a tooth number, select the appropriate tooth/teeth in the 
graphical chart.

3.	 Specify the procedure by using a procedure button, a procedure code category button, or the Procedures 
menu.

4.	 Do one of the following:

•	 If the selected procedure requires the selection of quadrants, sextants, or arches, the Quadrant 
Selection, Sextant Selection, or Arch Selection dialog box appears. Select the applicable treatment 
areas, and then click OK.

          

•	 If the selected procedure requires the selection of surfaces, the Surface Selection dialog box appears. 
Do one of the following:

•	 If one tooth is selected:

a.	 Select the applicable treatment areas.

b.	 Click OK.
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•	 If multiple teeth are selected:

a.	 With the first tooth selected in the list on the left, select the check boxes of the applicable 
surfaces, and then click Add.

b.	 Do one of the following for the other teeth listed:

•	 To apply the specified surfaces to all the other teeth listed, click Apply to all teeth. On 
the confirmation message that appears, click either Yes to apply the surfaces to all the 
teeth listed (you can change the surfaces of any tooth as needed before you click OK) or 
No to apply the surfaces to only the selected tooth (you must then add surfaces to each 
tooth separately before you click OK).

•	 To add surfaces to each tooth separately, select a different tooth in the list on the left, 
select the check boxes of the applicable surfaces, and then click Add. Repeat this process 
as needed for the other teeth listed.

Notes:

•	 You can also change the surfaces for any tooth in the list by selecting that tooth.

•	 To continue, every tooth in the list must have at least one surface applied.

c.	 Click OK.

5.	 Click the Treat Plan status button.



Chapter 9: Chart    97

Dentrix Enterprise 11.0.48 Learner’s Guide

Linking Conditions and Treatment-
planned Procedures
You can link multiple conditions to a treatment-planned procedure, or alternatively you can link a treatment-
planned procedure to a condition. To link a condition and a treatment-planned procedure, they must both 
already be charted. Linking a condition and a treatment-planned procedure allows you to have that condition 
invalidated automatically when you complete the corresponding treatment-planned procedure.

To link a condition to a treatment-planned procedure

1.	 In Chart, with a patient selected, on the Progress Notes panel, double-click the treatment-planned 
procedure that you want to link a condition to.

The Edit or Delete Procedure dialog box appears.

2.	 Click the Conditions search button .

The Select Condition Codes dialog box appears.

3.	 Select the check box of any condition that you want the procedure to be linked to.

4.	 Click OK.



98    Chapter 9: Chart

Dentrix Enterprise 11.0.48 Learner’s Guide

5.	 Select an Invalidate Upon Completion option to specify how you want to handle the invalidation of the 
conditions that the procedure is linked to when you complete the procedure (if it has been treatment-
planned):

•	 None – The conditions that the procedure is linked to will not be invalidated.

•	 Automatic – The conditions that the procedure is linked to will be invalidated automatically.

•	 With Verification – You will choose which conditions you want to invalidate.

6.	 Click OK.

To link a treatment-planned procedure to a condition

1.	 In Chart, with a patient selected, on the Progress Notes panel, double-click the condition that you want 
to link a treatment-planned procedure to.

The Change Condition dialog box appears.

2.	 Under Link to Treatment Plan, click Select.

The Select Treatment Plan dialog box appears.

3.	 Select the treatment-planned procedure that you want to link to the condition, and then click OK.

4.	 In the Change Condition dialog box, click OK.
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Invalidating Conditions
When you complete a treatment-planned procedure that has conditions linked to it, those conditions can be 
invalidated automatically. In contrast, conditions that are not linked to treatment-planned procedures do not 
get invalidated automatically when a related treatment-planned procedure is completed. However, you can 
manually invalidate an unlinked condition posted in Chart.

To invalidate a linked condition when completing a treatment-planned procedure

1.	 To complete a treatment-planned procedure, complete the appointment that has that treatment plan 
attached to it as explained in “Completing Appointments” in Chapter 8: Appointment Book.

One of the following occurs, depending on the selected invalidation option for the procedure as explained 
in “Linking Conditions and Treatment-planned Procedures” in this chapter:

•	 None – The conditions that the procedure is linked to are not invalidated. (Ignore the steps that 
follow.)

•	 Automatic – The conditions that the procedure is linked to are invalidated automatically. (Ignore the 
steps that follow.)

•	 With Verification – You choose which conditions you want to invalidate. The Invalidate Conditions 
dialog box appears. Proceed to step 2.

2.	 Leave the Invalidate check box of each of the conditions that you want to have invalidated selected. Clear 
the Invalidate check box of each of the conditions that you do not want to have invalidated.

3.	 Click Invalidate.

To invalidate an unlinked condition manually

1.	 In Chart, with a patient selected, on the Progress Notes panel, double-click a condition.
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The Change Condition dialog box appears.

2.	 Under Change Condition Options, select Invalidate Condition.

3.	 In the as of field, leave the current system date entered, or type a past date to specify the correct date that 
the condition became invalid.

4.	 Enter any Notes to explain why this condition is being invalidated.

5.	 Click OK.
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Referring Treatment to Off-site 
Specialists
Occasionally you may need to refer a patient to an off-site specialist. You can refer a procedure to an off-site 
provider from Chart. When you refer a procedure to an off-site provider, that procedure stays in your records 
as diagnosed, but Dentrix Enterprise does not assess any fees for it. Also, the procedure is not considered 
unscheduled treatment.

Important: Before referring treatment to an off-site provider, you must assign the appropriate Dental Priority 
Classification (DPC) to the treatment-planned procedure and then wait for a dental authorization review 
(DAR) to be performed.

To refer a procedure to an off-site provider

1.	 Assign a DPC 5 to the treatment-planned procedure that is to be referred to an off-site specialist by doing 
one of the following:

•	 In a patient’s Treatment Planner, change the approval status of the procedure as explained in 
“Changing the Approval Status of a Treatment Plan” in Chapter 12: Treatment Planner.

•	 In a patient’s Chart, do the following:

a.	 On the Progress Notes panel, double-click the procedure.

The Edit or Delete Procedure dialog box appears.

b.	 Under Procedure Status on the right, from the Approval Status list, select DPC 5.

c.	 Click OK.

2.	 After receiving an approval through the DAR process, with the patient selected in Chart, on the Progress 
Notes panel, double-click the treatment-planned procedure.
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The Edit or Delete Procedure dialog box appears.

3.	 Under Related Referral, click the Referred search button .

The Select Referral Type dialog box appears.

4.	 Select Referred To Doctor.

5.	 Click OK.

The Select Referred To dialog box appears.

Note: If the list is long, you can filter it by name. In the Enter Name field, type all or part of the referral 
source name, and then click the search button .

6.	 Select the off-site specialist to whom you are referring this treatment.

7.	 Click OK.

8.	 In the Edit or Delete Procedure dialog box, click OK.

The treatment’s status changes from TP to RTP.

9.	 When the patient returns from the off-site specialist, after reviewing the notes received from the specialist, 
set the procedure complete in the patient’s Chart:

a.	 Select the procedure on the Progress Notes panel of the patient’s Chart.
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b.	 Click the Set Complete button  to the right of the progress notes.

10.	Record the review of the specialist’s notes by creating a clinical note as explained in “Entering Clinical 
Notes Manually” in Chapter 11: Clinical Notes.

11.	Scan the specialist’s documents into the patient’s Document Center as explained in “Scanning 
Documents” in Chapter 7: Document Center. When entering the document information as explained 
in “Editing Document Information” in Chapter 7: Document Center, be sure to select Dental Other/
Outside Providers as the Document Type.

Referring Treatment to In-house 
Specialists
Occasionally you may need to refer a patient to an in-house specialist. You can refer a procedure to an in-
house provider from Chart. When you refer a procedure to an in-house provider, that procedure stays in 
your records as diagnosed, but Dentrix Enterprise does not assess any fees for it. Also, the procedure is not 
considered unscheduled treatment.

Important: Before referring treatment to an in-house provider, you must assign the appropriate Dental 
Priority Classification (DPC) to the treatment-planned procedure and then wait for a dental authorization 
review (DAR) to be performed.

To refer a procedure to an in-house provider

1.	 Assign a DPC 5 to the treatment-planned procedure that is to be referred to an in-house specialist by 
doing one of the following:

•	 In a patient’s Treatment Planner, change the approval status of the procedure as explained in 
“Changing the Approval Status of a Treatment Plan” in Chapter 12: Treatment Planner.

•	 In a patient’s Chart, do the following:

a.	 On the Progress Notes panel, double-click the procedure.
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The Edit or Delete Procedure dialog box appears.

b.	 Under Procedure Status on the right, from the Approval Status list, select DPC 5.

c.	 Click OK.

2.	 After receiving an approval through the DAR process, schedule an appointment for the patient with the 
in-house specialist (such as an oral surgeon) as explained in “Scheduling Appointments for Treatment 
Requests in Chapter 8: “Appointment Book.”

3.	 After the in-house specialist completes the treatment, set the procedure complete by completing the 
appointment as explained in “Completing Appointments” in Chapter 8: “Appointment Book.”
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Changing Progress Note Views
While working in Chart it may be advantageous to view only certain treatment information. For example, 
while explaining treatment to a patient, you might want to display just the graphical chart; or, while reviewing 
a patient’s history, you might want to view only completed procedures and conditions on the Progress Notes 
panel. By providing multiple ways to view treatment information, Dentrix Enterprise makes it simple to 
review cases and make treatment recommendations.

Viewing the Work Chart
By default, Chart always opens with the work chart displayed. The work chart consists of the graphical chart, 
progress notes, procedure buttons, procedure code category buttons, and status button. While in the work 
chart view, you can enter conditions, chart existing and completed work, and treatment plan.

To view the work chart

With a patient selected in Chart, from the Options menu, click Work Chart.

Tip: You can resize the window, if needed. Dentrix Enterprise stores the Chart window’s dimensions upon 
being closed so that, when you re-open Chart, it will open as the same size.

Viewing the Full-screen Chart
The graphical chart in Chart visually depicts the condition of the patient’s mouth. Treatment is drawn on the 
graphical chart using textbook charting symbols. In addition, treatment is color-coded to indicate the status 
of the treatment. For instance, completed work can be shown in blue, while recommended treatment can be 
shown in red. For use as a patient education tool, you can expand the graphical chart to fill the entire Patient 
Chart window.

To view the full screen chart

With a patient selected in Chart, from the Options menu, click Full Screen Chart.

Tip: You can resize the window, if needed. Dentrix Enterprise stores the Chart window’s dimensions upon 
being closed so that, when you re-open Chart, it will open as the same size.

Viewing the Progress Notes
You view the progress notes so that they become the focus of Chart instead of the graphical chart.

To view the progress notes

With a patient selected in Chart, from the Options menu, click Progress Notes.

The Progress Notes panel expands to fill nearly the entire Chart window.
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Viewing Progress Notes by Selected Teeth
If a patient has an extended treatment history, you can display only treatment related to a specific tooth or 
teeth in the Progress Notes panel.

To view the progress notes by selected teeth

1.	 With a patient selected in Chart, select the tooth or teeth for which you want to see progress notes.

2.	 From the View menu, click View by Selected Teeth. If no teeth are selected, this option will display 
progress notes for all teeth in the graphical chart.

The progress notes view is updated, and the selected tooth/teeth are deselected.

3.	 To remove this view setting, from the View menu, click View by Selected Teeth (the option will have a 
check mark next to it if it is in use).

Viewing Progress Notes as of a Certain Date
You can view a patient’s progress notes as of a certain date. Only treatment or conditions entered on or before 
the specified date are shown.

To view the progress notes as of a certain date

1.	 With a patient selected in Chart, from the View menu, click Chart As Of Date.

The View Chart as of Date dialog box appears.

2.	 Select one of the following options:

•	 As of – To view treatment and conditions on or before a certain date. Click the search button  to 
select a date.

•	 As of Today (Default View) – To view all treatment and conditions regardless of the date.

3.	 Click OK to apply the change.

4.	 To remove this view setting, from the View menu, click Chart As Of Date (the option will have a check 
mark next to it if it is in use).
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Viewing Progress Notes by Status
Progress notes can be listed according to a specific status option(s). For example, you can have the Progress 
Notes panel display only treatment-planned procedures, or you can choose to show treatment-planned and 
completed procedures.

To view the progress notes by status

With a patient selected in Chart, on the right side of the Progress Notes panel, select any of the following 
check boxes:

•	 Treat Plan – To display only treatment-planned procedures.

•	 Completed – To display only completed procedures.

•	 Existing – To display only procedures with a status of existing other

•	 Conditions – To display all conditions entered into the Patient Chart and the corresponding Dental 
Diagnostic codes

•	 Exams – To display a line for each Perio exam

•	 Proc. Notes – To display procedure notes

•	 Clinic Notes - To display clinical notes

Posting Treatment to Supernumerary 
Teeth
Because it is not possible to view or select a supernumerary tooth in the graphical chart, it is necessary to post 
the procedure to the nearest tooth and then edit the posted procedure with the appropriate supernumerary 
tooth number.

To post treatment to a supernumerary tooth

1.	 In Chart, with a patient selected, select the tooth that is nearest to the supernumerary tooth.

2.	 To make a note of the supernumerary tooth, click the Conditions procedure code category button, and 
then double-click Supernumerary Tooth Adjacent.

3.	 Post the treatment to the tooth that is nearest to the supernumerary tooth as explained in “Charting 
Treatment Needs” in this chapter.

4.	 On the Progress Notes panel, double-click the procedure that you just posted.
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The Edit or Delete Procedure dialog box appears.

3.	 Change the Tooth number based on the following ADA recommendations:

•	 Permanent Teeth – Add 50 to the tooth number nearest the supernumerary tooth (for example, 1 = 
51, 2 = 52, 3 = 53, and 32 = 82).

•	 Primary Teeth – Add an “S” after the tooth letter nearest the supernumerary tooth (for example, A = 
AS, B = BS, C = CS, and T = TS).

On the message that appears, asking if you want to accept the tooth number as supernumerary, click Yes.

4.	 Click OK.
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Editing Procedures
After treatment has been entered into Chart, you can make changes to the procedure, as needed, as long as the 
procedure is not in history or attached to a claim. For example, you may need to backdate a procedure that 
was posted after the actual date of service (dental encounter).

To edit treatment

1.	 In Chart, with a patient selected, from the Progress Notes panel, double-click the treatment item you 
want to change.

The Edit or Delete Procedure dialog box appears.

2.	 Make any necessary changes:

•	 Date – Type the correct date of the procedure.

•	 Clinic – To change the clinic, click the search button  to select the correct clinic.

•	 Procedure – To change the procedure code, click the search button  to select the correct code.

•	 Treatment area – To change the treatment area do one of the following: 

•	 For a tooth, type the correct Tooth number or letter (or supernumerary tooth number or letter).

•	 For a Surface, Quadrant, Arch, or Sextant, click the corresponding search button  to select 
the correct area.

•	 Amount – Type the correct amount charged for the procedure.
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•	 Provider – To change the provider attached to the procedure, click the search button  to select the 
correct provider.

•	 Notes – Make any necessary changes to the note, and specify the reason for the procedure needing to 
be changed (for auditing purposes)

3.	 Click OK.

4.	 Since posted procedures are automatically added into a clinical note with date they are entered, you 
need to enter a narrative as to why the correction was made or the procedure was backdated. Edit or 
add another page to the day’s clinical note for the patient’s visit. For information about editing clinical 
notes and adding pages to clinical notes, see “Editing Clinical Notes” and “Appending Clinical Notes” in 
Chapter 11: Clinical Notes.

Deleting Procedures
You can delete completed, treatment-planned, or existing procedures that were posted in error unless the 
procedure is in history or attached to a claim. You can also delete conditions.

To delete a completed, treatment-planned, or existing procedure

1.	 In Chart, with a patient selected, on the Progress Notes panel, double-click the completed, treatment-
planned, or existing procedure you want to delete.

The Edit or Delete Procedure dialog box appears.
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2.	 Click Delete.

3.	 On the confirmation message that appears, click OK.

To delete a treatment-planned or existing procedure

1.	 In Chart, with a patient selected, on the Progress Notes panel, click the treatment-planned or existing 
procedure you want to delete.

Tip: To select multiple procedures, while pressing the Ctrl key, click each procedure.

2.	 Click the Delete button .

3.	 On the confirmation message that appears, click OK.

4.	 Since posted procedures are automatically added into a clinical note, you need to enter a narrative as to 
why the deletion was made. Edit or add another page to the day’s clinical note for the patient’s visit. For 
information about editing clinical notes and adding pages to clinical notes, see “Editing Clinical Notes” 
and “Appending Clinical Notes” in Chapter 11: Clinical Notes.

Invalidating Procedures
Dentrix Enterprise saves your office from repetitive data entry by posting procedures to both Ledger and 
Chart at the same time. However, a different standard regarding record keeping exists for each module. 
Ledger, as a financial record, uses generally accepted accounting principles (GAAP). In contrast, Chart is a 
clinical record of patient care.

Then, what do you do when you discover a posting error for a procedure in a month that has been closed out? 
The procedure has been locked to prevent deletions and changes, which is good for a financial record, and you 
can simply enter an adjustment in the Ledger to correct the problem. However, the clinical record needs to 
accurately represent the actual care given, but you can’t delete or change the procedure or “adjust” the clinical 
record in Chart.

To solve this discrepancy, Dentrix Enterprise allows you to invalidate a procedure in history (in closed out 
months). Invalidating a procedure removes it from Chart while leaving it in Ledger.

To invalidate a procedure

1.	 In Chart, with a patient selected, on the Progress Notes panel, double-click a procedure in history.
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The Validate/Invalidate Procedure in History dialog box appears.

2.	 Under Validate/Invalidate Procedure, click Invalidate Procedure.

3.	 Click OK.

The invalidated transaction is removed from Chart but left in Ledger as a history transaction. In Ledger, 
a plus sign (+) appears to the left of the transaction description to indicate that the transaction has been 
invalidated.

Important:

•	 Post an offsetting adjustment equal to the amount of the procedure, as the account has already been 
billed for that procedure.

•	 If needed, post the procedure again using the correct information. Be sure to change the date to 
reflect the date the procedure was originally posted, and change the charge amount to zero because 
the account has already been billed for the procedure.

4.	 Since posted procedures are automatically added into a clinical note, you need to enter a narrative as 
to why the correction was made. Add another page to the day’s clinical note for the patient’s visit. For 
information about adding pages to clinical notes, see “Appending Clinical Notes” in Chapter 11: Clinical 
Notes.
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Editing Conditions
You can edit a condition that has been posted in Chart.

To edit a condition

1.	 In Chart, with a patient selected, on the Progress Notes panel, double-click the condition that you want 
to edit.

The Change Condition dialog box appears.

2.	 Change the following details as needed:

•	 Date – Enter the correct date when the condition was discovered (by you, the patient, or another 
provider).

•	 Procedure – To select a different condition, click the search button . Only codes in the Conditions 
category are available for selection.

•	 Tooth – If applicable, enter the correct tooth number or letter (or supernumerary tooth number or 
letter).

•	 Other treatment areas – Do one the following if applicable:

•	 For a surface, click the Surface search button  to select the correct surface.

•	 For a quadrant, click the Quadrant search button  to select the correct quadrant.

•	 For an arch, click the Arch search button  to select the correct arch.

•	 For an sextant, click the Sextant search button  to select the correct sextant.

•	 Provider – To select a different provider, click the search button .

•	 Clinic – To select a different clinic, click the search button .

•	 Change Condition Options – Invalidate or validate the condition.

•	 Notes – Enter or modify the notes regarding the condition.

•	 Link to Treatment Plan – Link a treatment-planned procedure to this condition, or unlink a linked 
treatment-planned procedure.

3.	 Click OK.
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Printing a Patient’s Chart
You can print a patient’s chart.

To print a patient’s chart

1.	 In Chart, with a patient selected, from the File menu, click Print Dental Chart.

The Print Options dialog box appears.

2.	 Select the desired print options:

•	 Print Todays Work – Select this option if you want to print completed work posted on the current 
system date.

•	 Print Treatment Plan – Select this option if you want to print treatment-planned work that was 
posted on the current system date.

If you want to include a list of treatment-planned work and the billed amount, patient portion, and 
insurance portion of each, select Print TP Estimate Detail.

•	 Print Chart as Displayed – Select this option if you want the report to include the graphical chart.

3.	 Click OK to send the report to the Chart printer.
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Printing Progress Notes and the 
Patient Chart
You can print the progress notes and graphical chart as they are currently being viewed in Chart.

To print the progress notes with the chart

1.	 In Chart, with a patient selected, from the File menu, click Print Progress Notes With Chart.

The Print Progress Notes with Chart dialog box appears.

2.	 Set up the following options:

•	 Note Range – To print all displayed progress notes, select All Progress Notes; or, to print notes 
specific to a certain date range, select Date Range, and then type a date range.

•	 Print Procedure Amounts – To include amounts for procedures that appear on the report.

3.	 Click OK.
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Viewing Patient Education Topics
You can provide education resources to a patient according to that patient’s medical alerts/problems, 
medications/prescriptions, allergies, and laboratory test results. This feature uses a database of patient 
education topics that are available on the MedlinePlus website. The content of this website is sponsored/
backed by the government.

To view a patient education topic

1.	 Do one of the following:

•	 With a patient selected in a patient-specific module, such as Chart, click the Patient Education 

button . The Patient Education dialog box appears. Skip step 2.

•	 With a prescription selected in a patient’s Patient Prescription dialog box, click the Patient 

Education button .

Depending on a clinic setting, one of the following occurs:

•	 If there is a valid NDC associated with the selected prescription, the MedlinePlus website opens 
in a browser window and displays the relevant patient topics, if any. Ignore the steps that follow. 
However, if there are no relevant topics, a message appears and asks if you want to search the 
patient topic database. Proceed to the next step.

•	 The MedlinePlus website opens in a browser window and displays the patient education topics, 
if any, that match the description of the selected prescription. The Record Patient Education 
dialog box opens but is behind the browser window. Skip to step 8.

•	 With an alert/problem, a medication/prescription, or an allergy selected in a patient’s Medical Alerts 

dialog box, click the Patient Education button .

Depending on a clinic setting, one of the following occurs:

•	 If there is a valid SNOMED-CT code associated with the selected alert/problem or allergy, or 
if there is a valid NDC associated with the selected prescription/medication, the MedlinePlus 
website opens in a browser window and displays the relevant patient topics, if any. Ignore the 
steps that follow. However, if there are no relevant topics, a message appears and asks if you want 
to search the patient topic database. Proceed to the next step.

•	 The MedlinePlus website opens in a browser window and displays the patient education topics, if 
any, that match the description of the selected alert/problem, medication/prescription, or allergy. 
The Record Patient Education dialog box opens but is behind the browser window. Skip to step 
8.

•	 With a lab test result selected in a patient’s Lab Tests dialog box under Lab Results for Selected Lab 
Order (for a selected lab order) or under All Lab Results, click Education.

Depending on a clinic setting, one of the following occurs:

•	 If there is a valid LOINC code associated with the selected lab test, the MedlinePlus website 
opens in a browser window and displays the relevant patient topics, if any. Ignore the steps that 
follow. However, if there are no relevant topics, a message appears and asks if you want to search 
the patient topic database. Proceed to the next step.

•	 The MedlinePlus website opens in a browser window and displays the patient education topics, if 
any, that match the description of the selected lab test. The Record Patient Education dialog box 
opens but is behind the browser window. Skip to step 8.

2.	 Click Yes.
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The Patient Education dialog box appears.

3.	 Select a category: Problems, Medications, or Lab Tests.

4.	 Do one of the following:

•	 Type all or part of the description or code for a topic that you want to view, and then click the search 
button  to view a list of topics that match your search criteria. Proceed to the next step.

•	 Type the words that you want to search for, and then click Search Online to browse topics on the 
MedlinePlus Connect website that match your search criteria. Ignore the steps that follow.

Note: The search field allows for dashes (-).

5.	 Select the topic that you want to view.

6.	 Select whether you want to view the selected topic in English or Spanish. The default selection is 
determined by the patient’s selected language and a clinic setting.

7.	 Click Show Education.

The MedlinePlus website opens in a browser window and displays the patient topics that match either the 
description or code (according to a certain clinic setting) of the selected topic.
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8.	 In the Record Patient Education dialog box, change the Date, Provider, and/or Education URL as 
needed. Then, either click Record to record that you provided the patient with education resources, or 
click Don’t Record to not record an entry in the patient’s education history.

Online search Show education (for selected topic)

Tip: To view information regarding the patient education topics that have been recorded previously for the 
patient, in the Patient Education dialog box, click History. The Patient Education History dialog box 
appears.
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Chapter 10: Perio Chart
In Perio Chart, you can record clinical attachment levels, pocket depths, gingival margins, mobility, plaque, 
calculus, bone loss, bleeding and suppuration points, furcation grades, and MGJ measurements.

Note: A Periodontal Screening Record (PSR) is not calculated in Perio Chart. You can enter this information 
in a clinical note.

To open the Perio Chart

In Chart, with a patient selected, click the Perio button  on the toolbar.

Perio Chart opens. If the patient does not have a perio exam for today, a new exam is started.

Notes:
•	 Perio Chart provider is the provider who is selected in Chart.
•	 If a previous perio exam exists for the patient, when Perio Chart opens, the data chart displays the data 

from that exam. You can update any of the measurements as needed as you perform a new exam. The 
updates will be saved as a new exam for today. The previous exam is not affected and remains in history.
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The Perio Chart Window
The Perio Chart window is divided into the following areas: the data chart, tooth indicator controls, 
navigation controls, and data entry controls.

Data chart Tooth indicator controls

Navigation controls Data entry controls

Note: When you open Perio Chart, the actions that you have been granted permission to perform appear 
in the lower-right corner. If you attempt to perform an action in Perio Chart that is prohibited, a user with 
adequate security rights can override the restriction temporarily so you can complete the task.
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Entering New Perio Examinations
A default path has been set up to advance the exam automatically to surfaces and teeth throughout the 
dentition. With the default path, you enter probing depths in the following order: #1 – 16, facial; #16 – 1, 
lingual; #17 – 32, facial; and then #32 – 17, lingual.

You can also chart conditions, such as bleeding, suppuration, gingival margin, mobility, furcation grade, and 
bone loss.

Notes:

•	 You can enter probing depths using the keyboard as you proceed along the default path. Alternatively, you 
can enter probing depths in the Probing Depths boxes.

•	 Probing depths of 4 millimeters or greater appear in red font on the perio chart.

•	 While recording periodontal measurements, if you deviate from the default path to perform a manual 
entry, you will be advanced automatically the next tooth in the path after the one that you just entered 
measurements for.

•	 Each row on the periodontal graphical chart represents one or more measurements or conditions 
recorded.

•	 Tooth codes (TC) transfer over from Chart. A tooth code appears for a tooth if a condition has been 
posted for that tooth. Some conditions will cause the corresponding tooth to be skipped in the recording 
paths.

To enter a new perio examination

1.	 Do one of the following:

•	 If you open Perio Chart, and the patient does not have a perio exam for today, a new exam is started 
automatically.

Note: If the patient has a past exam, the data chart displays the data from that exam, and you can 
save time by entering only the measurements that have changed since the last exam; otherwise, the 
data chart is blank.

•	 If you are viewing a past exam in Perio Chart, on the File menu, click New Exam.

Notes:

•	 The Perio Chart provider is the provider who is selected in the Chart.

•	 To select a different script for charting the exam, on the Options menu, point to Select Script, and 
then click an option. The selected script will be selected by default for all subsequent exams that you 
start until you select a different script either from the Options menu or in the Perio Entry Setup 
dialog box. The script selection is saved per user.

2.	 Record probing depths for all the facial sites of teeth 1 through 16.

Note: The yellow area of the tooth data chart represents the buccal/facial surfaces of teeth.

3.	 Record probing depths for all the lingual sites of teeth 16 through 1.

Note: The blue area of the tooth data chart represents the lingual surfaces of teeth.

4.	 Record probing depths for all the facial sites of teeth 17 through 32.

5.	 Record probing depths for all the lingual sites of teeth 32 through 17.
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6.	 To record periodontal conditions for any tooth, do the following:

a.	 Select the facial (yellow) or lingual (blue) area of the tooth. If the correct tooth is already selected, and 
you need to switch from either facial to lingual or lingual to facial, click the *Facial/Lingual button.

Note: The tooth number you selected appears in the Tooth # box at the top of the area to the right of 
the data chart.

b.	 Specify any of the following:

•	 B (Bleeding) – Click a “B” oval to indicate a bleeding point on the tooth. A red oval that 
corresponds to the selected tooth and site appears on the data chart.

•	 S (Suppuration) – Click an “S” oval to indicate an infection point on the tooth. A yellow oval 
that corresponds to the selected tooth and site appears on the data chart.

•	 Gingival Margin – Enter the gingival margin measurements.

•	 MGJ – Enter the mucogingival junction measurements.

•	 Mobility – Click the desired mobility classification. The number appears in the center placement 
of the PMB line on the data chart.

•	 Furcation Grades – Click the search button  to select the appropriate furcation.

•	 Plaque – From the list, select the appropriate plaque classification. A corresponding number 
appears in the left placement of the PMB line on the data chart.

•	 Bone Loss – From the list, select the appropriate bone loss classification. A corresponding 
number appears in the right placement of the PMB line on the data chart.

7.	 From the File menu, click Save Exam to save the exam.

Notes:

•	 If you do not save the exam manually, when you close Perio Chart, a message will appear and ask you 
to save the exam.

•	 If the Perio Chart provider was changed automatically, if you close Perio Chart after having started a 
new exam without saving it, a message regarding the provider being changed automatically appears.

Charting Probing Depths Greater 
than 9 Millimeters
You can enter pocket depths that are greater than 9 millimeters using the on-screen keyboard in Perio Chart.

To enter a pocket depth greater than 9 millimeters

1.	 Select the facial (yellow) or lingual (blue) area of the tooth.

2.	 Click the appropriate surface box under Probing Depths.

3.	 Click the 1- button, and then click a number button. For example, to record 12 mm, you would click 1- 
and then 2.

Note: A measurement greater than 9 mm appears as a greater-than sign [>] on the data chart.
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Recording Gingival Inflammation
You can note whether a pocket is related to a Gingival Margin (GM) that is above the Cemento-Enamel 
Junction (CEJ) by using the keyboard buttons.

To enter gingival inflammation

1.	 Select the facial (yellow) or lingual (blue) area of the tooth.

2.	 Click the appropriate surface box under Gingival Margin.

3.	 To enter a gingival margin that is above the CEJ as a positive number to indicate inflammation and not 
loss of attachment click the + button, and then click a number button. For example, to record 2 mm, you 
would click + and then 2.

Note: The positive gingival margin appears as a black box with white number on the data chart.
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Entering Diagnostics
In addition to perio measurements, other perio data can be added to the current perio exam. This data can be 
used to create customized letters for insurance companies, patients, and so forth.

To add diagnostic information to the current exam

1.	 On the menu bar, click Diagnostics.

The Perio Clinical Notes dialog box appears.

2.	 Set up the following options:

•	 GINGIVA – Select the options appropriate to the condition of the patient’s gingiva: Color, Texture, 
Margins, Attachment, Papillae, Sulcus, Contour, Bleeding, and Suppuration. Some of the lists 
have a “None” option.

•	 X-RAYS – Select the options appropriate to any Bone Loss and Bone Defects indicated by an X-ray. 
Both of the lists have a “None” option.

•	 ORAL HYGIENE – Select the options appropriate to the state of the patient’s oral hygiene: Plaque, 
Calculus, and Stain. All of the lists have a “None” option.

•	 MISCELLANEOUS – Type any miscellaneous information.

•	 Periodontal Case Type – Select the appropriate type for the patient.

•	 Patient Status – Select the appropriate patient status.

•	 Perio Status – Select the appropriate perio status.

3.	 If you want to copy the information in the Perio Clinical Notes dialog box to the Clipboard in a text 
format, click Copy to Clipboard.

4.	 If you want to save the current selections as the defaults for the next time you open the Perio Clinical 
Notes dialog box for any patient, click Save as Default.

5.	 If you want to view statistics about the patient’s perio condition, probing depths, and clinical attachment 
level, click Summary Totals.

6.	 Click OK to save the diagnostic information as a permanent part of the current exam.
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Comparing Perio Exams
To help you educate your patients regarding periodontal disease progression, you can compare up to four 
saved perio exams with the current exam.

To compare exams

1.	 In Perio Chart, from the Options menu, click Exam Comparison.

The Perio Comparative Selections dialog box appears.

2.	 Under Compare, select the type of comparison that you want view:

•	 Probing Depths (Data) – To review a data comparison of probing depth measurements.

•	 Gingival Margin – To review a comparison of gingival margin measurements. Select whether to view 
a Graphic or Data representation.

•	 Clinical Attachment Level – To review a comparison of CALs. Select whether to view a Graphic or 
Data representation.

•	 Mobility – To review a data comparison of mobility measurements.

•	 Furcation Involvement – To review a data comparison of furcation grades.

3.	 Under Display, select what you want to display: MGJ Line, Bleeding, Suppuration, Mobility, or 
Furcation Involvement. These options are not available if Probing Depths (Data) is selected under 
Compare.

4.	 Under Select Comparison Exam, select the exams you want to compare to the current exam.

5.	 Click OK.
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The comparison appears.

Changing the Perio Exam View
From the Perio Chart, you can view perio data in several different formats:

•	 Graphic Chart

•	 Combined Graphic and Data Chart

•	 Quadrants
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Viewing the Graphic Chart
Unlike the data chart, which displays perio data numerically, the Perio Chart’s graphic chart view displays 
numeric perio data in a graphical representation. You cannot add or change data while in the graphic chart 
view.

To view the graphic chart

In Perio Chart, from the Options menu, click Graphic Chart.
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Viewing the Combined Graphic and Data 
Chart
In Perio Chart, you can view a combination of the data chart and graphic chart. Numerical data appears above 
the graphic portion of the chart. You cannot add or change data while in the data and graphic chart view.

To view the combined graphic and date chart

In Perio Chart, from the Options menu, click Combined Graphic & Data Chart.

Viewing Quadrants
You can enlarge a quadrant to view that area close up.

To zoom in on a quadrant

1.	 While viewing the data chart or graphic chart, click in the quadrant you want to view.

2.	 From the Options menu, click Quadrant Zoom.

3.	 If you want to zoom back out to see all quadrants or to select a different quadrant to zoom in on, while 
in the quadrant zoom mode, right-click anywhere in the window to zoom out so that all quadrants are 
being viewed in the graphic chart (the pointer changes to a magnifying glass), and then click the desired 
quadrant.

4.	 When you are finished using the quadrant zoom feature, from the Options menu, click Quadrant Zoom 
again to get out of the quadrant zoom mode.
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Chapter 11: Clinical Notes
Keeping accurate and thorough documentation of each procedure performed in the dental office is an essential 
part of clinical dentistry. In Dentrix Enterprise, you can enter a clinical note to store information about a 
patient’s exam and treatment that are not specific to a procedure.

Notes:

•	 A dental clinical note will be added automatically to the corresponding patient’s medical record (in 
PowerChart) when that note is signed. Medical notes are not added automatically to patients’ dental 
records.

•	 There may be times when a clinical note is entered without a code being posted. For example, if an 
appointment is not needed for a patient’s treatment request, create a clinical note using the No Face to 
Face template, and enter the reason for the patient not needing an appointment in that clinical note.

Viewing Clinical Notes
You will access Clinical Notes from Appointment Book or Chart.

To view clinical notes

With a patient’s appointment selected in Appointment Book, click the Clinical Notes button  on the 
toolbar.
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Clinical Notes opens.

To see all the pages of all clinical notes, click the Expand All button .

To see the pages of a specific clinical note, click the plus sign (+) next to a date and then a note. When you 
select a page, you should see all of the posted procedures.

Changing the Provider
If the correct provider is not attached to the page of a clinical note, you can change the provider.

To change the provider for a note

1.	 With a clinical note page selected, click the Change Provider for Selected Note button  on the 
toolbar.

The Select Provider dialog box appears.

2.	 Select a provider, and then click OK.
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Entering Clinical Notes Using Templates
You can use templates to quickly create and add to clinical notes.

To enter a clinical note using a template

1.	 Do one of the following:

•	 To add a clinical note, click the New Clinical Note button . The Change Date and Time dialog 
box appears. Leave the current date and system time entered, or type a different date and time. Then, 
click OK.

Important: The date of the clinical note should be the date of service (dental encounter).

•	 To add a page to an existing clinical note, with that note selected, click the New Clinical Note Page 

button . The Change Time dialog box appears. Leave the current system time entered, or type a 
different time. Then, click OK.

Note: If a clinical note page is not selected when you choose a template, a new clinical note will be added. 
So, to add a template to an existing note, make sure the correct page of that clinical note is selected.

2.	 If you are adding a clinical note without a corresponding scheduled appointment, you must attach an 
encounter number to the clinical note. If the Edit Encounter Number dialog box does not appear 
automatically, to attach an encounter number to the clinical note, do the following:

a.	 Click the Change Encounter For Selected Note button .

b.	 Click Select by Date.

c.	 Search for and select the correct encounter number, and then click OK.

Note: You should select the open encounter (the encounter without a discharge date) that 
corresponds with the patient’s status (either outpatient for an institutional encounter or inpatient 
for an inpatient setting). Selecting the correct encounter in Dentrix Enterprise ensures that 
documentation in the EHRS is associated with the correct encounter.

d.	 Click OK.
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3.	 In the template pane (on the right), expand a category to view the list of available templates for that 
category by clicking the plus sign (+) next to the category name, and then double-click the desired 
template.

4.	 Respond to the prompts associated with the template, if applicable.

The template text and any responses you entered appear in the note field (in the middle).

Note: You can edit the note or add additional information as needed.

5.	 Click the Save Clinical Note button .

Entering Clinical Notes Manually
You can create a clinical note with text that you enter manually.

To enter a clinical note

1.	 Do one of the following:

•	 To add a clinical note, click the New Clinical Note button . The Change Date and Time dialog 
box appears. Leave the current date and system time entered, or type a different date and time. Then, 
click OK.

Important: The date of the clinical note should be the date of service (dental encounter).

•	 To add a page to an existing clinical note, with that note selected, click the New Clinical Note Page 

button . The Change Time dialog box appears. Leave the current system time entered, or type a 
different time. Then, click OK.

2.	 If you are adding a clinical note without a corresponding scheduled appointment, you must attach an 
encounter number to the clinical note. If the Edit Encounter Number dialog box does not appear 
automatically, to attach an encounter number to the clinical note, do the following:

a.	 Click the Change Encounter For Selected Note button .
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The Edit Encounter Number dialog box appears.

b.	 Click Select by Date.

c.	 Search for and select the correct encounter number, and then click OK.

Note: You should select the open encounter (the encounter without a discharge date) that 
corresponds with the patient’s status (either outpatient for an institutional encounter or inpatient 
for an inpatient setting). Selecting the correct encounter in Dentrix Enterprise ensures that 
documentation in the EHRS is associated with the correct encounter.

d.	 Click OK.

3.	 Type the text of the note in the field in the middle of the window.

4.	 Click the Save Clinical Note button .
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Editing Clinical Notes
You can edit a clinical note that has note been signed.

To edit a clinical note

1.	 With a clinical note’s page selected, edit existing text, type other text manually, or insert text by using a 
template.

2.	 Click the Save Clinical Note button .

Signing Clinical Notes
Once a clinical note has been completed, sign it.

Tip: You can also sign clinical notes from Signature Manager (which you can access from Office Manager).

To sign a clinical note

1.	 With a clinical note’s page selected, click the Sign Clinical Note button .

2.	 If an encounter number is not already attached to the clinical note, the Select Encounter Number dialog 
box appears. Search for and select the correct encounter number, and then click OK.

Note: You should select the open encounter (the encounter without a discharge date) that corresponds 
with the patient’s status (either outpatient for an institutional encounter or inpatient for an inpatient 
setting). Selecting the correct encounter in Dentrix Enterprise ensures that documentation in the EHRS is 
associated with the correct encounter.
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The Update DPC Status dialog box appears.

3.	 Do one of the following:

•	 Update the status – Verify that the correct Provider is selected. If it is not, click the search button 
 to select the correct provider. Next, select the correct status based on the patient’s treatment 

plans. Then, click Select.

•	 Do not update the status – If the patient’s DPC has already been set for the visit, click Skip DPC.

Notes:

•	 If you updated the DPC, a “Signed on [date]” stamp is added to the end of the clinical note.

•	 If you skipped updating the DPC, a “[User ID] selected Skip DPC button for DPC update” stamp is 
added to the end of the clinical note.

•	 If you select a clinical note that has been signed, the Sign Clinical Note button  changes to the 

Signature button .

•	 The background of a signed clinical note’s page becomes gray to indicate that it is signed and locked.

Appending Clinical Notes
You cannot edit a clinical note that has been signed. However, if errors or omissions are discovered after a 
clinical note has been locked, it must be appended in order to make any corrections or additions. You can add 
a page to a signed clinical note to append it.

To append a clinical note

1.	 With a note selected, click the New Clinical Note Page button . The Change Time dialog box 
appears. Leave the current system time entered, or type a different time. Then, click OK.

2.	 Create the clinical note as explained in “Entering Clinical Notes Using Templates” in this chapter.

3.	 Click the Save Clinical Note button .

4.	 Sign the clinical note page as explained in “Signing Clinical Notes” in this chapter.
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Using Signature Manager
You can review and sign clinical notes from Signature Manager.

Note: You cannot make updates or addendums to clinical notes from Signature Manager. You must do so 
from Clinical Notes for the corresponding patient.

To view clinical notes in the Signature Manager

1.	 While logged in to Dentrix Enterprise as the user who needs to sign clinical notes, in Office Manager, 

click the Signature Manager button .

The Signature Manager dialog box appears.

2.	 Set up the following Filters as needed:

•	 Date Range Selection – Select one of the following options:

•	 Previous – To view clinical notes for the specified number of days prior to today’s date. Enter the 
number of days.

•	 Date Range – To view clinical notes within the specified date range. Select the starting and 
ending dates of the range.

•	 Any Date – To view clinical notes for any date.

•	 Clinic Selection – Select one of the following options:

•	 Current Clinic – To view clinical notes for the clinic that you are currently logged in to.

•	 Other – To view clinical notes for specific clinics or all clinics. Either click the search button  
to select the clinics whose clinical notes you want to view, or select the All check box to include 
all clinics’ clinical notes.

•	 Provider Selection – Click the search button  to select the providers whose clinical notes you 
want to view, or select the All check box to include all providers’ clinical notes.

•	 Status Selection – Select whether you want to view all, unsigned, or signed clinical notes.

3.	 Click the Refresh button  to apply the specified filters.

Only the clinical notes that match the specified criteria appear in the list.

4.	 For each clinical note that you need to sign, do the following:

a.	 Select the clinical note to review it.

b.	 Click the Sign button  to sign the clinical note as explained in “Signing Clinical Notes” in this 
chapter.
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Chapter 12: Treatment Planner
In Treatment Planner, you can organize treatment based on a patient’s Dental Priority Classification (DPC). 
Also, you can prioritize treatment and set the Approval Code. Dentrix Enterprise automatically adds all 
procedures that are treatment-planned from the Patient Chart into the default treatment plan case folder.

To open Treatment Planner, with a patient selected in Chart, click the Treatment Planner button  on the 
toolbar.

The Treatment Planner window consists of a menu bar, toolbars, the Treatment Plan panel, the case details, 
and the graphical chart or progress notes.

Treatment Plan Panel Case Details Graphical Chart
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Viewing Treatment Plans
The Treatment Plan Case Setup section on the Treatment Plan panel displays the treatment plan cases that 
have been created for a patient.

Prioritizing Treatment Plans
When more than one visit is required to complete a treatment plan case, you can organize the procedures in 
that case into visits, so you know which procedures will be done in each visit.

To order procedures by visit

1.	 In Treatment Planner, on the Treatment Plan panel, from the Treatment Plan Case Setup section, 
expand the appropriate case by clicking the plus sign (+).

2.	 Select the procedures that will be completed in one visit (to select multiple, while pressing the Ctrl key, 
click each procedure). Next, right-click one of the selected procedures, and then click Create Visit.

Repeat this step for all subsequent visits of the treatment plan. As visits are created, the number of the 
visit increases (1, 2, 3, and so forth). The specified visit numbers appear next to the procedures.

Note: The visit order also appears for your reference when selecting a Tx appointment reason from the 
Appointment Information dialog box.

3.	 After you have prioritized treatment in the case, you must change the status of the case to “Accepted.” Any 
additional treatment will go into a new case folder. To accept the case, do the following:

a.	 Select the case folder.

b.	 Click the Update Case Status button , and then click Accepted on the button menu.



Chapter 12: Treatment Planner    139

Dentrix Enterprise 11.0.48 Learner’s Guide

The Update Current Case Status dialog box appears.

c.	 Leave today’s date entered, or select the correct date that the case was accepted.

d.	 Enter any relevant notes.

e.	 Click OK.

Changing Treatment Plan Approval 
Statuses
After prioritizing a treatment plan, the dentist can assign a DPC code to each procedure of that plan. This 
information will be transferred back to the Treatment Request Manager and the Unscheduled Treatment Plan 
list of the Scheduling Assistant.

To change the approval status of an individual procedure

1.	 In a treatment plan case folder, double-click a procedure.
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The Edit or Delete Procedure dialog box appears.

2.	 Under Procedure Status on the right, from the Approval Status list, select a DPC code.

3.	 Click OK.

To change the approval status of multiple procedures

1.	 In a treatment plan case folder, select procedures, right-click one of the selected procedures, and then click 
Assign Treatment Approval Status.
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The Assign Treatment Approval Status dialog box appears.

2.	 From the Select Treatment Approval Status list, select the DPC code that you want to apply to all the 
selected procedures.

3.	 Click OK.

Note: If any of the selected procedures already has an approval status, and it is different from the status that 
you selected in the Assign Treatment Approval Status dialog box, the approval status will be changed for 
those procedures.

Rejecting Treatment Plans
If a patient refuses all or certain treatment, you can reject those procedures in Treatment Planner. Rejected 
treatment is removed from the odontogram.

To reject all treatment in a case

1.	 Select a treatment plan case folder.

2.	 Click the Update Case Status button , and then click Rejected on the button menu.

The Update Current Case Status dialog box appears.The Update Current Case Status dialog box 
appears.

Note: If any procedures have linked conditions, a note appears at the bottom of the dialog box to inform 
you that the associated conditions will be unlinked from the rejected procedures.

3.	 Leave today’s date entered, or select the correct date that the case was rejected.

4.	 Enter the reason that the treatment was refused.

5.	 Click OK.

To reject partial treatment

1.	 Create a new treatment plan case folder as explained in “Creating Treatment Plan Cases” in this chapter.

Note: If you need to rename the folder, you can do so by right-clicking it and clicking Rename Case.

2.	 Drag the rejected procedures into the new folder.
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3.	 Click the Update Case Status button , and then click Rejected on the button menu.

The Update Current Case Status dialog box appears.

4.	 Leave today’s date entered, or select the correct date that the case was rejected.

5.	 Enter the reason that the treatment was refused.

6.	 Click OK.

To reject irrelevant treatment

If, for example, an RCT was treatment planned for a tooth, but that tooth was subsequently extracted, create 
a new case folder, put that extraction procedure in it, and then reject the new case.

Creating Treatment Plan Cases
To maximize the patient experience, you want make treatment planning customized and personal, but you 
also want to maintain efficiency. When you post treatment-planned procedures in Ledger or Chart, Dentrix 
automatically places those procedures into a default treatment plan case in Treatment Planner. However, you 
can create additional treatment plan cases to group and organize procedures. This allows you to track the 
status of or prioritize various courses of treatment.

To create a new case

1.	 In Treatment Planner, on the Treatment Plan panel, from the Treatment Plan Case Setup section, click 

the New Case button .

The new case appears in the case list.

2.	 Type a name for the case, and then press Tab or Enter to apply the name.
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3.	 All treatment-planned procedures are automatically added to the default case (“Treatment Plan” is the 
name if it has not been renamed). Select the desired procedures in the default case (to select multiple 
procedures, while holding down the Ctrl key, click the procedures), and then drag the selected procedures 
to the new case.

Tip: If all the procedures in the default treatment plan case will be put into the same case, you can rename 
the default case to avoid having to create a new case and move the procedures into the new case.

Deleting Treatment
You can delete existing treatment-planned procedures that are not in history. For example, if a panorex was 
treatment planned a year ago and is no longer necessary, you can delete that procedure.

To delete a treatment-planned procedure

1.	 In Treatment Planner, on the Treatment Plan panel, from the Treatment Plan Case Setup section, 
expand the appropriate case by clicking the plus sign (+), and then double-click a procedure.
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The Edit or Delete Procedure dialog box appears.

2.	 Click Delete.

3.	 On the confirmation message that appears, click OK.

The treatment-planned procedure is removed from Treatment Planner, Chart, and Ledger-Treatment 
Plan.

Tip: To delete multiple procedures at the same time, in the Treatment Plan Case Setup section, while 
pressing the Ctrl key, click the procedures you want to delete. Next, right-click one of the selected procedures, 
and then click Delete Procedure(s). Then, on the confirmation message that appears, click Yes.

Moving Treatment Between Cases
To move treatment between cases, select the desired procedures in one case (to select multiple procedures, 
while holding down the Ctrl key, click the procedures), and then drag the selected procedures to another case.
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Printing the Patient Treatment Case 
Report
You can print the Patient Treatment Case Report for the current patient and customize the data that appears 
on the report.

To generate the Patient Treatment Case Report

1.	 In Treatment Planner, on the Treatment Plan panel, click the Print button , and then click Patient 
Treatment Case Report on the button menu.

The Patient Treatment Case Report dialog box appears.

3.	 Set up any of the following options:

•	 Procedure Code Date Range – Enter a date or date range of treatment-planned procedures posted in 
the range to include. To include all dates, select All Dates for From and To.

•	 Case Fee Expiration Date Range – Enter a date or date range of cases with an expiration date within 
that range to include. To include all dates, select All Dates for From and To.

•	 Select Provider – To select a provider or range of providers for the patient’s treatment-planned 
procedures to include, click the From and To search buttons , and select the providers. To include 
all providers, leave From “<ALL>” To “<ALL>” entered.

•	 Report Options:

•	 Select the options that correspond to the information you want to include.

•	 To include a comparison of the current fee schedule to a selected fee schedule, select the 
Compare to Fee Schedule search button , and select a fee schedule.
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•	 Include Cases With – Select the case statuses that you want to include, or select All to include all 
statuses. Also, select the case severities that you want to include, or select All to include all severity 
levels.

•	 Patient Privacy – Select the options that correspond to the patient information you want to exclude.

Tips:

•	 To save the current report settings as a set for the next time you run this report, select Save as 
Default.

•	 To preview the report before printing it, select Print Preview.

4.	 Click OK.
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Chapter 13: End of Day
At the end of the day, do the following:

1.	 Verify that all appointments are set complete in Appointment Book.

2.	 Verify that all procedures are completed by generating a day sheet.

3.	 Sign any unsigned clinical notes from Signature Manager.

4.	 Verify that there are not any patient credit balances by generating an aging report.

Verifying Completed Appointments
While viewing today in Appointment Book, all appointments should be grayed out. For information about 
completing appointments, see “Completing Appointments” in Chapter 8: Appointment Book.

Generating a Day Sheet
To make sure that each patient who was seen today has had a procedure posted and that a visit co-pay and/or 
dental lab fee has been charged.

To generate a day sheet

1.	 In Office Manager, click the DXOne Reports button  on the toolbar.



148    Chapter 13: End of Day

Dentrix Enterprise 11.0.48 Learner’s Guide

DXOne Reporting opens.

2.	 From the Select Report Category list box, select Management.

3.	 In the Double Click to Launch Report Options list box, double-click Day Sheet.

The Day Sheet dialog box appears.

4.	 Set up the following options:

•	 Date Range – Do one of the following:

•	 Leave Specific Range selected and today’s date entered in the From and To fields.

•	 Select Relative Date Range, and then select Current Day from the list.

Note: For a credit or charge to be included on the report, it must have a date within the date range or 
relative date range, based on the Date Type.
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•	 Date Type – Select whether to run the report by Entry Date or Procedure Date. Entry date 
indicates the date of a transaction that was entered into the database. Procedure date indicates the 
date of a transaction that was manually changed. Most of the time, procedures will have the same 
entry and procedure date. They will only differ when you backdate a procedure. Applied credits use 
the allocate date instead of entry or procedure date.

•	 Clinic – Click the search button  to select the clinics you want to include on the report, or leave 
All selected to include all clinics. Select whether to run the report by Collecting Clinic or Rendering 
Clinic.

•	 When specific clinics are selected for the Collecting Clinic, the report will include the following:

•	 Credits where the collecting clinic is specified

•	 Charges where the rendering clinic is specified

•	 When specific clinics are selected for the Rendering Clinic, the report will include the following:

•	 Suspended credits where the collecting clinic is specified

•	 Applied credits where the rendering clinic is specified

•	 Charges where the rendering clinic is specified

•	 Provider/Staff – Click the search button  to select the providers/staff members you want to 
include on the report, or leave All selected to include all providers and staff members.

The following stipulations apply when selecting a provider:

•	 The report will only include transactions associated with the rendering provider(s) specified.

•	 If any providers are specified, the report will not include any suspended credits regardless of the 
group by option specified.

•	 Billing Type – Click the search button  to select the billing types for the patients you want to 
include on the report, or leave All selected to include all billing types.

•	 Patient Tag – To have the report include patients with certain tags assigned to them, select the Run 
By Patient Tag check box; and then click the search button  to select the desired patient tags, or 
leave All selected to include all patient tags. To not filter the report by patient tag, clear the Run By 
Patient Tag check box.

•	 Group By – Select one of the following options:

•	 No Group By – For no grouping. Only the grand totals appear on the report. The totals are not 
broken down by clinic or provider.

•	 Clinic – To group the report by clinic. The totals are broken down by clinic, and the report 
displays grand totals.

Do one of the following:

•	 To not group the report by provider within each clinic grouping, clear the Provider check 
box. The report displays a charge with its associated rendering clinic. The report displays a 
suspended credit with its associated collecting clinic. The report displays an applied credit 
with either the rendering clinic of the charge that it’s applied to or its collecting clinic.

•	 To group the report by provider within each clinic grouping, select the Provider check box. 
For each provider, the report displays totals that are related to the outer clinic grouping. 
The report displays a charge with its associated rendering provider. The report displays a 
suspended credit under a “SUSPENDED CREDITS” grouping. The report displays an 
applied credit with the rendering provider of the charge that it’s applied to.
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•	 Provider – To group the report by provider. Totals are broken down by provider, and the report 
displays grand totals.

Do one of the following:

•	 To not group the report by clinic within each provider grouping, clear the Clinic check 
box. The report displays a charge with its associated rendering provider. The report displays 
an applied credit with the rendering provider of the charge that it’s applied to. With this 
grouping option, the report does not display suspended credits because suspended credits are 
not associated with a provider.

•	 To group the report by clinic within each provider grouping, select the Clinic check box. 
For each clinic, the report displays totals that are related to the outer provider grouping. The 
report displays a charge with its associated rendering clinic. The report displays an applied 
credit with either the rendering clinic of the charge that it’s applied to or its collecting clinic. 
With this grouping option, the report does not display suspended credits because suspended 
credits are not associated with a provider.

•	 Billing Type – To group the report by billing type. Totals are broken down by billing type, and 
the report displays grand totals.

Do one of the following:

•	 To group the report by billing type without a secondary grouping, select the No Subgroup 
option.

•	 To group the report by clinic within each billing type grouping, select the Clinic option. For 
each clinic, the report displays totals that are related to the outer billing type grouping. The 
report displays a charge with its associated rendering clinic. The report displays an applied 
credit with either the rendering clinic of the charge that it’s applied to or its collecting clinic. 
With this grouping option, the report does not display suspended credits because suspended 
credits are not associated with a provider.

•	 To group the report by provider within each billing type grouping, select the Provider 
option. For each provider, the report displays totals that are related to the outer billing type 
grouping. The report displays a charge with its associated rendering provider. The report 
displays an applied credit with the rendering provider of the charge that it’s applied to.

If all providers are selected for Provider/Staff, the report displays a suspended credit under 
a “SUSPENDED CREDITS” grouping. If specific providers (instead of all providers) 
are selected for Provider/Staff, the report does not include a “SUSPENDED CREDITS” 
grouping.

If specific providers (instead of all providers) are selected for Provider/Staff, the totals and grand 
totals do not include suspended credits, other applied credits, or other applied credit initial 
balances.

•	 Layout Options – Click Phone # to display the patient’s phone number next to the procedure, or 
Chart # to display the patient’s chart number next to the procedure.

•	 Report Detail Sort – Select either Alphabetical to sort the transactions alphabetically by the last 
names of patients or Chronological to sort the transactions by date according to the Date Type.

5.	 Click Save as Default to save the current settings for the next time you run the report.

6.	 Click Clear Defaults to revert the dialog box options to the original defaults.

7.	 Click Schedule to open the Schedule Report dialog box and schedule the report to be emailed.

8.	 Click OK to preview the report.
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Signing Clinical Notes
You can identify and sign any unsigned clinical notes in Signature Manager. For information about reviewing 
and signing clinical notes, see “ Using Signature Manager” in Chapter 11: Clinical Notes.

Generating the Aging/Credit Balance 
Report
As visit co-pays and dental lab fees are posted, Dentrix Enterprise will automatically adjust off the balance in 
the Ledger. If an error is made in posting either of those adjustments, and it was subsequently deleted, Dentrix 
Enterprise will not automatically remove the adjustment. The adjustment will have to be deleted manually.

To verify that all patient balances have been adjusted off, generate the Aging/Credit Balance Report.

To generate an aging report

1.	 In Office Manager, click the DXOne Reports button  on the toolbar.

DXOne Reporting opens.

2.	 From the Select Report Category list box, select Ledger.

3.	 In the Double Click to Launch Report Options list box, double-click Aging/Credit Balance.
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The Aging/Credit Balance dialog box appears.

4.	 Set up the following options:

•	 Aged Balance as of – Enter the Aged Balance as of date, which is the date from which to age the 
balances. Remember the following when typing a date:

•	 The credit or charge must have a date prior to or equal to the date entered.

•	 Credits that have been applied to charges use the applied date to determine if the date is less than 
or equal to the aged balance date.

•	 All charges and suspended credits use the entry date or procedure date (whichever is specified) to 
determine if the date is less than or equal to the aged balance date.

•	 Last Pmt Before – The Last Pmt Before date can be used to exclude accounts that have made a 
payment recently. For example, if the date is for the prior month, any accounts that have a guarantor 
payment for that prior month will be excluded from the aging report. Insurance payments are 
ignored.

•	 Clear ALL and enter a date to include accounts that have made payments before the specified 
date. Also, if ALL is not selected, a guarantor will only show on the report when his/her last 
payment (guarantor payment) was made prior to the date entered.

•	 Leave ALL selected to include all accounts, regardless of the date of the last payment.

•	 Date Type – Select whether to run the report by Entry Date or Procedure Date. Entry date 
indicates the date of a transaction that was entered into the database. Procedure date indicates the 
date of a transaction that was manually changed. Most of the time, procedures will have the same 
entry and procedure date. They will only differ when you backdate a procedure. Applied credits use 
the allocate date instead of entry or procedure date.

•	 Balance Range – Select Exclude Zero Balances to include all credit or debit balances on the report.

•	 Guarantor – Click the From and/or To search buttons  to select the range of guarantors you 
want to include on the report (the range can be open-ended), or leave both All check boxes selected 
to include all guarantors.
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•	 Clinic – Click the search button  to select the clinic that you are verifying balances in. With a 
specific clinic selected, the report will include the following:

•	 Suspended credits where the collecting clinic is specified

•	 Charges where the rendering clinic is specified

•	 Applied credits assume the charges are for the rendering clinic. Therefore, if a charge doesn’t 
show because of the clinics specified, and the applied date is on or before the aged balance date 
specified, the applied amount will not show and is not considered suspended.

•	 Provider – Click the search button  to select the providers you want to include on the report, 
or leave All selected to include all providers. When specific providers are selected, the report will 
include/exclude the following:

•	 Include transactions associated with the rendering provider(s) specified.

•	 Not include any suspended credits, regardless of the Group By option specified.

•	 If a charge doesn’t show because of the providers specified, and the applied date is on or before 
the aged balance date specified, the applied amount will not appear.

•	 Billing Type – Click the search button  to select the billing types for patients you want to include 
on the report, or leave All selected to include all billing types.

•	 Patient Tag – To have the report include patients with certain tags assigned to them, select the Run 
By Patient Tag check box; and then click the search button  to select the desired patient tags, or 
leave All selected to include all patient tags. To not filter the report by patient tag, clear the Run By 
Patient Tag check box.

•	 Aging Intervals – Enter the aging intervals, in days, as you want them to appear on the report. Each 
guarantors balance will be aged by the ranges specified in each of the six interval buckets. Clinic and 
provider groupings are also aged using these same buckets.

•	 Days Past Due – Select the Minimum days past due: 0, 30, 60, 90, 120, 150, or 180. For example, 
if you only want accounts with a balance over 60 days, select “60.” Select the Maximum days past 
due: <No Limit>, 30, 60, 90, 120, 150, or 180. For example, if you do not want to include any 
accounts with an aged balance over 90 days, select “90.”

•	 Group By – You have the following options:

•	 Guarantor – Click this option to group the report by guarantors.

•	 Only Guarantors – Click this option to list balances by guarantor name.

•	 Click Clinic or Provider to group the report first by guarantor name and then by clinic for 
each guarantor. Clinics listed are based on the charges for the rendering clinic and suspended 
credits for the collecting clinic.

•	 Click Provider to group the report first by guarantor name and then by provider for each 
guarantor. Providers listed are based on the charges provider. Suspended credits are included 
on the report but are only shown under the guarantor grouping.

•	 Clinic/Guarantor – Click this option to group the report first by clinic and then by guarantor 
name. Clinics listed are based on the charges for the rendering clinic and suspended credits for 
the collecting clinic.

•	 Provider/Guarantor – Click this option to group reports first by provider and then by guarantor 
name. Providers listed are based on the charges provider. Suspended credits are not included with 
this grouping.
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•	 Sort Options – You have the following options:

•	 By Guarantor Name – Click this option to sort the report first by the grouping specified and 
then alphabetically by guarantor name.

•	 By Over 180 to Current Balance – Click this option to sort the report first by the grouping 
specified (whatever is entered as the last aging interval) and then by the oldest to newest balance.

•	 By Largest to Smallest Balance – Click this option to sort the report first by the grouping 
specified and then by the largest to smallest balance.

•	 Other Options:

•	 Include Guarantor Notes – Select this check box if you want to include the patient’s guarantor 
note. With this check box selected, any guarantors with a note will print below the guarantor 
information. This check box is only available when the Group By option is set to Guarantor 
(with any sub-grouping).

5.	 Click Save as Default to save the current settings for the next time you run the report.

6.	 Click Clear Defaults to revert the dialog box options to the original defaults.

7.	 Click Schedule to open the Schedule Report dialog box and schedule the report to be emailed.

8.	 Click OK to preview the report.

9.	 If any balances are listed, post adjustments to those accounts to make their balances be zero.

10.	Re-run the report to make sure that there are no accounts listed.
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Chapter 14: Continuing Care
You can use Continuing Care to track the following:

•	 Perio maintenance for patients

•	 Patients who have a Plaque Index (PI) score over 20

•	 Lab cases for prosthetics

•	 Biopsy cases

You will generate Continuing Care lists only for lab cases.

Tracking Perio Maintenance
You will post a D4910 to track a periodontal maintenance for a patient. If needed, you can also change the 
interval for that continuing care type for a patient.

To record periodontal maintenance

1.	 In Chart, with a patient selected, make sure the appointment provider’s name appears on the title bar. If 
not, change the provider as explained in “Changing the Provider for a Charting Session” in Chapter: 9: 
Chart.

2.	 Click the Periodontics procedure code category button, and then double-click D4910   Periodontal 
maintenance.

3.	 Click the Comp status button.

The procedure appears in the progress notes, and the associated continuing care type, PERIO, is attached 
to the patient’s record.
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To view and modify a patient’s continuing care

The continuing care types attached to a patient’s record appear in the Cont. Care block of Family File.

If you need to change when the patient is eligible for a follow-up visit for a specific continuing care type, such 
as PERIO, you can change the interval of that continuing care type.

To edit a patient’s continuing care

1.	 With a patient selected in Family File, double-click the Cont. Care block.

The Patient Continuing Care dialog box appears.

2.	 Select the continuing care type that you want to edit.

3.	 Click Edit.

The Edit Continuing Care dialog box appears.

4.	 To set the interval for the patient’s continuing care, click the Due Date search button .
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The Set Interval dialog box appears.

5.	 Change the Interval to reflect the amount of time that elapses between the patient’s continuing care visits. 
Select +1 Day to extend the interval an extra day to prevent insurance billing problems for patients with 
strict interval requirements.

6.	 Click OK.

7.	 In the Edit Continuing Care dialog box, click OK.

Tracking Plaque Index > 20
You will post the in-house code C1020 to track Plaque Index >20 for a patient.  Show how the continuing 
care module will track this patient.

To enter a plaque index over 20

1.	 In Chart, with a patient selected, make sure the appointment provider’s name appears on the title bar. If 
not, change the provider as explained in “Changing the Provider for a Charting Session” in Chapter 9: 
Chart.

2.	 Click the In-House procedure code category button, and then double-click C1020   Plaque Index > 20.

3.	 Click the Comp status button.

The procedure appears in the progress notes, and the associated continuing care type, PI>20, is attached 
to the patient’s record.

To view a patient’s continuing care

The continuing care types attached to a patient’s record appear in the Cont. Care block of Family File.
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Tracking Lab Cases
You can use Continuing Care to track a patient’s lab case.

Lab Out
To start the tracking of a lab case, post the correct procedure, and then verify that the correct continuing care 
type is attached to the patient’s record and that the type has the correct status.

To post a lab case procedure

1.	 In Chart, with a patient selected, make sure the appointment provider’s name appears on the title bar. If 
not, change the provider as explained in “Changing the Provider for a Charting Session” in Chapter 9: 
Chart.

2.	 If the treatment need you are entering requires a tooth number, select the appropriate tooth/teeth in the 
graphical chart.

3.	 Specify a prosthetic procedure, such as D7110, by using a procedure button, a procedure code category 
button, or the Procedures menu.

If the selected procedure requires additional treatment information (surfaces, quadrants, sextants, or 
arches), the Surface Selection, Quadrant Selection, Sextant Selection, or Arch Selection dialog box 
appears.

               

4.	 Select the applicable treatment areas, and then click OK.

Note: For surface selections, if multiple teeth have been selected, the treatment areas you specify will be 
applied to all those teeth.

5.	 Click the Comp status button.

The procedure appears in the progress notes, and the associated continuing care type, LAB CASE, is 
attached to the patient’s record.
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To verify the initial status of a lab case

1.	 With a patient selected in Family File, double-click the Cont. Care block.

The Patient Continuing Care dialog box appears.

2.	 Select the LAB CASE continuing care type.

3.	 Click Edit.

The Edit Continuing Care dialog box appears.

The selected Status should be Lab Out.

4.	 Click OK.

5.	 In the Patient Continuing Care dialog box, click Close.
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Lab In
When a lab case is received back from the lab, change the status of the patient’s Lab continuing care type, and 
then schedule the patient for an appointment.

To change the status of a lab case

1.	 With a patient selected in Family File, double-click the Cont. Care block.

The Patient Continuing Care dialog box appears.

2.	 Select the LAB CASE continuing care type.

3.	 Click Edit.

The Edit Continuing Care dialog box appears.

4.	 Change the Status to Lab In.

5.	 Click OK.

6.	 In the Patient Continuing Care dialog box, click Close.
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7.	 Review the patient’s prosthetic procedure in Chart to see if an additional lab fee needs to be posted. Do 
not edit the original fee.

To post an additional lab fee, do the following:

a.	 In Chart, with the patient selected, make sure the treating provider’s name appears on the title bar. If 
not, change the provider as explained in “Changing the Provider for a Charting Session” in Chapter 
9: Chart.

b.	 Click the Lab Use Only procedure code category button, and then double-click the additional lab 
procedure.

c.	 Click the Comp status button.

d.	 Locate the clinical note that was created when you posted the additional lab procedure. For 
information about viewing clinical notes, see “Viewing Clinical Notes” in Chapter 11: Clinical Notes.

 Note: The provider will have to sign the clinical note.

e.	 If the provider for the clinical note is not the treating dentist, change the provider as explained in 
“Changing the Provider” in Chapter 11: Clinical Notes.

8.	 Schedule the patient’s appointment for the lab case from Scheduling Assistant as explained in “Scheduling 
Appointments from Scheduling Assistant” in Chapter 3: Scheduling Assistant.

Note: You do not attach a treatment request to a follow-up appointment for a prosthesis.

Lab Delivered
When the prosthetic appliance is delivered, clear the Lab Case continuing care type from the patient’s record.

Important: You can view all outstanding lab cases from Scheduling Assistant. Make sure to delete all delivered 
cases from the list to keep it accurate.

To stop tracking a lab case

1.	 In Scheduling Assistant, filter the list to view only the patients with the Lab Case continuing care type 
attached to their records as explained in “Customizing the Continuing Care Filter Settings” in Chapter 3: 
Scheduling Assistant

2.	 Click the patient’s name (which is a hyperlink).

The patient’s More Information window opens.

3.	 Click the Family File button .

The patient’s Family File opens.

4.	 Double-click the Cont. Care block.
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The Patient Continuing Care dialog box appears.

5.	 Select the LAB CASE continuing care type.

6.	 Click Clear.

7.	 On the confirmation message that appears, click Yes.
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Chapter 15: Ledger
Ledger contains all the procedures posted from Appointment Book or Chart. For the most part, you will 
use Ledger only to view procedures. If a procedure has been entered in error, the provider can edit or delete 
it from Chart. However, it will be necessary to edit or delete the adjustment associated with the edited or 
deleted procedure in the Ledger.

For information about editing and deleting procedures, see “Editing Procedures,” “Deleting Procedures,” and 
“Invalidating Procedures” in Chapter 9: Chart.

Ledger Toolbar
The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

The function of each button on the toolbar is explained in the following table.

Button Name Description

 More Information Opens the selected patient’s More Information window.

 Patient Chart Opens the selected patient’s Patient Chart.

 Family File Opens the selected patient’s Family File.

 Appointment Book Opens the Appointment Book module.

 Office Manager Opens the Office Manager module.

 Quick Letters Opens the Quick Letters dialog box.

 Continuing Care Opens the selected patient’s Continuing Care list.

 Prescriptions Opens PowerChart.

 Office Journal Opens the selected patient’s Office Journal.
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Button Name Description

 Document Center Opens the selected patient’s Document Center.

 Message Center Opens the Cerner Message Center.

 Patient Education Opens the Patient Education dialog box.

 Select Patient Opens the Select Patient dialog box to select a patient.

 Guarantor Notes Opens the selected patient’s Guarantor Notes dialog box.

 Treatment Planner Opens the selected patient’s Treatment Planner.

 Enter Payment Opens the Enter Payment dialog box to enter a patient payment.

 Enter Procedure Opens the Enter Procedure(s) dialog box.

 Print Walkout Prints a walkout statement.

 Print Statement Prints a billing statement.

 Print Family Ledger Prints a family ledger report.

 Fast Checkout Performs a fast check out.

 Medical Alerts Opens the selected patient’s Medical Alerts window.

 Clinical Notes Opens the selected patient’s Clinical Notes window.

 Patient Health Exchange Opens the selected patient’s Patient Health Exchange dialog box.

DXOne Reports Click to open DXOne Reporting to generate and manage reports.

Signature Manager Click to open the Signature Manager dialog box to sign multiple 
clinical notes at one time.

Scheduling Assistant Click to open the Scheduling Assistant window, which can help 
enhance your scheduling workflow.
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Viewing the Transaction Log
The transaction log is a written record of all transactions posted to a patient’s account. For each transaction, 
the date, patient name, tooth number and surface (when applicable), procedure code or type, a description, 
amount, provider, and clinic are shown.

You can sort the transaction log by clicking any of the column headers, such as the following:

•	 Date – The date of the transaction or procedure.

•	 Entry Date – The date that the transaction or procedure was entered. This may be different than the 
Date; for example, if you backdated the transaction or procedure.

•	 Tooth (Tooth Number) – The tooth associated with the procedure.

•	 Code (Procedure/Transaction Code) – The associated procedure code or financial transaction type 
(payment, adjustment, or so forth).

•	 * (Transaction Flags) – In this column, any of the following symbols may appear:

* – An asterisk indicates that the transaction has been moved to history. History transactions cannot 
be edited or deleted.

+ – A plus sign indicates that the procedure has been invalidated. Invalidated procedures still show in 
Ledger but no longer appear in Chart.

^ – A carat indicates that the procedure has been back dated to a month that has been closed out. 
When the procedure is moved to history, the carat will change to an asterisk.
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Editing Procedures
You can edit a procedure as needed, such as when you receive an invoice from a specialist for services 
performed off-site.

To edit a procedure

1.	 With a patient selected in Ledger, double click a procedure.

The Edit or Delete Procedure dialog box appears.

2.	 Make the necessary changes, such as correcting the Amount, changing the Provider, or entering Notes.

3.	 Click OK.
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Deleting Adjustments
You can delete an adjustment for a corresponding deleted procedure.

To delete an adjustment

1.	 With a patient selected in Ledger, double click an adjustment.

The Edit Or Delete Credit Adjustment dialog box appears.

2.	 Click Delete.

A confirmation message appears.

3.	 Click OK.

The patient’s Ledger balance should be zero.
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Generating a Walkout Statement
A walkout statement is generally given to a patient as a receipt of charges posted and payments made on the 
day of treatment.

To print a walkout statement

1.	 In Ledger, with a patient selected, do one of the following:

•	 If you have set up your walkout statement defaults, click the Print Walkout button  on the 
toolbar. Ignore the steps that follow.

•	 To override the walkout default options to print a different type of walkout for the patient. From the 
Print menu, click Walkout. The Print Report dialog box appears.

2.	 Under Select Report Types, select Walkout/Doctor’s Statement.

3.	 To include adjustments on the statement, select Print Adjustments.

4.	 If you have a standard message that you want to print on all walkout statements by default, type the note 
in the Message field.

5.	 If you are not doing a one-time override of the default options, to store your settings as the default 
options for the next time you print walkout statements, select Save as Default.

6.	 Click Send to Batch or Print.

Generating the Patient Ledger Report
The Patient Ledger Report shows transactions for the selected patient.

To print the Patient Ledger Report for one patient

1.	 In Ledger, with a patient selected, from the Print menu, click Patient Ledger.

The Patient Ledger Report dialog box appears.

2.	 Type a First Transaction Date. All transactions posted after the entered date will be included on the 
report.

3.	 Click Send to batch or Print.
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Chapter 16: Reports
Within Dentrix Enterprise, there are two areas from which you run reports:

•	 Office Manager – The reports here are mostly clerical reports that are specific to the clinic that a user is 
logged in to.

•	 DXOne Reporting – The reports here require a higher security level and are administrative reports. You 

access DXOne Reporting by clicking the DXOne Reports button  on the toolbar of Office Manager.

Single-User Mode Message
If a message, which states that the database is in single-user mode, appears when you attempt to open Dentrix 
Enterprise, one of your IT personnel has turned on this mode, so no other users can open Dentrix Enterprise. 
Once your IT person has turned off single-user mode, you can open Dentrix Enterprise.
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The Office Manager Toolbar
The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

The function of each button on the toolbar is explained in the following table.

Button Name Description

 More Information Opens the Select Patient dialog box to select a patient, and then 
selected patient’s More Information window opens.

 Patient Chart Opens the Patient Chart module.

 Family File Opens the Family File module.

 Ledger Opens the Ledger module.

 Appointment Book Opens the Appointment Book module.

 Office Journal Opens the Office Journal module.

 Document Center
Opens the Select Provider/Staff dialog box to select a provider 
or staff member, and then the selected person’s Document Center 
opens.

 Message Center Opens the Cerner Message Center.

 Print Preview Opens the Dentrix Print Preview window to display the report 
selected in the batch processor.

 Print Report(s) Prints the reports selected in the batch processor.

 Delete Report(s) Opens the Delete Options dialog box to delete all or certain 
reports.

 Refresh/Clear Selection Clears all report selections in the batch processor.

 DXOne Reports Opens the DXOne Reporting module.

 
Treatment Request 
Manager Opens the Treatment Request Manager window.

 Scheduling Assistant Opens the Scheduling Assistant window.

 Signature Manager Opens the Signature Manager dialog box to sign multiple clinical 
notes.
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Daily Appointment List
The Daily Appointment List lists all appointments for a selected range of dates and by the selected providers 
and operatory ranges. The list includes the appointment date, status, time, patient name, provider and 
operatory, appointment reason, and appointment duration.

To run the report

1.	 In Office Manager, from the Reports menu, point to Lists, and then click Daily Appointment List.

The Daily Appointment List dialog box appears.

2.	 Clear Operatory List, and select Daily Appointment List.

3.	 The default Report Date is the current system date. You can type a different date to have that date print 
at the top of the report.

4.	 Click OK to send the report to the Batch Processor, where it can be viewed or printed.
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Production Summary Report
With the Production Summary Report, you can review production by procedure code categories for a date 
range. Among other reasons, you will use the report to view the number of comprehensive exams that have 
been completed year-to-date for all clinics.

To run the report

1.	 In DXOne Reporting, select Analysis, and then double-click Production Summary.

The Production Summary dialog box appears.

2.	 Set up the following options:

•	 Date Range – Select Relative Date Range, and then select Current Calendar YTD.

•	 ADA Code – Click the search button  to include D0150 Comprehensive Exam on the report.

3.	 Click Save as Default if you want to save the current settings for the next time you run the report.

4.	 Click OK.
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Patient List
The Patient List displays a list of patients according to specified criteria, such as information from their 
medical alerts/problems, medications, prescriptions, demographics, and laboratory test results. For example, 
male patients in any date range, at any clinic, who have had a D2160 completed.

To run the report

1.	 In Office Manager, from the Analysis menu, click Patient List.

The Patient List - Select Template dialog box appears.

Note: You can run, edit, or delete any saved template from this dialog box.

2.	 Click Add.

The Patient List dialog box appears and displays the Filter Set screen.

3.	 Enter a List name if you are going to save your search criteria as a template for future use.
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4.	 For as many filters as you want to set up, under Double click on filter below, double-click each desired 
item to specify the criteria of that filter in the dialog box that appears (the name depends on the filter that 
you double-click):

5.	 Click the Next button .

The Filters Review screen appears.

6.	 Add any additional filter sets (click the Add Filter Set button , and then repeat steps 4 – 5). Then, 

click the Next button .

The Data Fields screen appears.

Note: If a data field specifically has the ability to show all records for a given data field regardless of the 
applied, corresponding filters, the data field will appear in the lower-right corner with a check box that 
may be selected to show all records pertaining to the specific data field type for a patient. Only certain 
data fields can allow this functionality.
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7.	 In the desired categories, double-click the data fields that you want to include. Then, click the Next 

button .

The Run screen appears and displays the results list.

Tips:

•	 To open the Ledger, Chart, or Family File of a patient on the list, right-click that patient’s name, and 
then click the desired menu option.

•	 Click a column header to sort the list by that column in ascending order. Click the same column 
header to switch to descending order for that column. To sort by multiple columns, click each 
column header in the order by which you want to sort (for example, first by patient name and then 
by the problem description; numbers appear next to the names of the column headers by which you 
are sorting). Right-click a column header to remove the sort option for that column.

•	 To print the list, click the Print button .

•	 To copy the list as tab-delimited text to the Windows Clipboard, click in the list, and then press Ctrl 
+ A and then Ctrl + C.

•	 To re-generate the list, to make sure you have the most current information, click the Run button 

.

8.	 To save the search criteria as a template, click Save.
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UDS - Encounter and User Statistics 
Report
The UDS - Encounter/User Statistics Report lists the number of encounters by provider and procedure code. 
This report uses the UDS (Uniform Data System) standards for reporting.

To run the report

1.	 In DXOne Reporting, select UDS, and then double-click UDS - Encounter/User Statistics.

The UDS - Encounter/User Statistics dialog box appears.

2.	 Set up the filters as needed.

3.	 Click OK:
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Unsigned Clinical Notes Report
The Unsigned Clinical Note Report is a list of patients with clinical notes that need approval (to be signed).

To generate the report

1.	 In Office Manager, click the DXOne Reports button  on the toolbar.

The DXONE Reporting dialog box appears.

2.	 From the Select Report Category list box, select List.

3.	 In the Double Click to Launch Report Options list box, double-click Clinical Notes.

The Clinical Notes dialog box appears.



178    Chapter 16: Reports

Dentrix Enterprise 11.0.48 Learner’s Guide

4.	 Set up the following options:

•	 Date Range – Do one of the following:

•	 Leave Date Range selected. Then, either leave today’s date entered in the From and To fields, or 
specify a different date range.

•	 Select Relative Date Range, and then select Current Day or a different date range option from 
the list.

Notes: 

•	 Using a relative date range is recommended if you are saving your report settings as the default so 
that you do not have to manually type a date range each time you run the report.

•	 For a clinical note to be included on the report, it must have a date within the date range or 
relative date range.

Also, select either Clinic Time to use the clinic time zone or UTC to use Coordinated Universal 
Time.

•	 Clinic – Click the search button  to select the clinics you want to include on the report, or leave 
All selected to include all clinics.

•	 Provider/Staff – Click the search button  to select the providers/staff you want to include on the 
report, or leave All selected to include all providers.

•	 Report Type – Select Notes Needing Approval to include clinical notes that have not been approved 
or signed.

5.	 Click Save as Default to save the current settings for the next time you run the report.

6.	 Click Clear Defaults to revert the dialog box options to the original defaults.

7.	 Click Schedule to open the Schedule Report dialog box and schedule the report to be emailed.

8.	 Click OK to preview the report.
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